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ApSIC Xbench consente di organizzare ed effettuare ricerche nella 
terminologia bilingue di riferimento. ApSIC Xbench offre inoltre svariati 
strumenti di QA (Quality Assurance, controllo qualità) che consentono di 
migliorare la qualità delle traduzioni. 

Funzioni di ricerca 
ApSIC Xbench consente di effettuare ricerche approfondite sui seguenti 
formati bilingue: 

 File di testo delimitato da tabulazione (*.txt, *.tsv, *.utx) 
 File XLIFF, incluse le varianti MemoQ XLIFF, MemSource XLIFF, 

Idiom XLIFF e altri tipi di XLIFF (*.xlf, *.xlif, *.xliff, *.xlz, 
*.mqxlz, *.mxliff) 

 Memorie TMX (*.tmx) 
 Glossari TBX/MARTIF (*.xml, *.tbx, *.mtf) 
 File TIPP (*.tipp) 
 Memorie esportate da Trados (*.txt) 
 Glossari MultiTerm 5 esportati da Trados (*.txt) 
 Glossari di Trados MultiTerm (*.xml, *.sdltb, *.mdb) 
 File di Trados TagEditor (*.ttx) 
 File bilingue di Trados Word (*.doc, *.rtf) 
 File di Trados Studio (*.sdlxliff, *.sdlproj) 
 Memorie di Trados Studio (*.sdltm) 
 File di memoQ, inclusi i pacchetti di consegna e di ritorno (*.mqxlz, 

*.mqxliff, *.mqout, *.mqback)  
 File ITD di SDLX (*.itd). Nota: questa opzione richiede la presenza 

di una versione di SDLX installata nel computer.  
 Memorie di SDLX (*.mdb) 
 Directory di STAR Transit 2.6/XV/NXT 
 File PO (*.po) 
 Dizionari esportati di IBM TranslationManager (*.sgm) 
 Cartelle di installazione ed esportazione di IBM TranslationManager 

(*.fxp)  
 Memorie esportate di IBM TranslationManager (*.exp) 
 Dizionari esportati di OpenTM2 (*.sgm) 
 Cartelle di installazione ed esportazione di OpenTM2 (*.fxp)  
 Memorie esportate di OpenTM2 (*.exp) 
 Memorie di Wordfast (*.txt) 
 Glossari di Wordfast (*.txt) 
 File di Wordfast Pro (*.txml) 

Panoramica 
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 File di Déjà Vu X/Idiom, incluse le versioni Satellite e Pack&Go 
(*.wsprj, *.dvprj, *.dvsat, *.dvpng) 

 Memorie di Déjà Vu X/Idiom (*.wstm, *.dvmdb) 
 File RTF di Logoport (*.rtf) 
 Glossari software di Microsoft (*.csv) 
 Glossari di Mac OS X (*.ad, *.lg) 
 File di Qt Linguist (*.ts) 
 Glossari di Passolo (*.glo) 
 Progetti in Transifex 
 Glossari di Remote Xbench Server 

La terminologia di riferimento può essere organizzata in vari livelli di 
priorità per indicare chiaramente ai traduttori le impostazioni specifiche 
di ogni progetto di traduzione.  

ApSIC Xbench è sempre attivo in background e può essere richiamato 
per ricercare un testo precedentemente selezionato utilizzando una 
combinazione di tasti personalizzabile (per impostazione predefinita è 
Ctrl+Alt+Insert). Questo metodo permette ricerche terminologiche 
immediate da qualsiasi applicazione di Windows utilizzando una 
semplice combinazione di tasti. 

ApSIC Xbench dispone di un motore di ricerca molto potente; non solo è 
possibile effettuare ricerche sul testo di partenza e sul testo di arrivo, ma 
anche ricerche con condizioni o ricerche per esclusione tramite la 
funzione PowerSearch (Ctrl+P). È inoltre possibile svolgere ricerche 
complesse utilizzando la sintassi delle espressioni regolari o dei caratteri 
jolly di Microsoft Word.  

Nota: dopo l’avvio, ApSIC Xbench opera in background fino a quando 
non viene chiuso con il comando Shutdown Xbench facendo clic con il 
pulsante destro del mouse sull’icona di Xbench nella barra delle attività 
di Windows o utilizzando il menu a discesa Project.  

Funzionalità di QA 
Nel proprio progetto di ApSIC Xbench, definendo i file di traduzione in 
corso come ongoing translation è possibile effettuare i seguenti controlli 
di QA: 

 Trovare segmenti non tradotti 
 Trovare segmenti con lo stesso testo di partenza ma con testo di 

arrivo differente 
 Trovare segmenti con lo stesso testo di arrivo ma con testo di 

partenza differente 
 Trovare segmenti in cui il testo di arrivo corrisponde al testo di 

partenza (testo potenzialmente non tradotto) 
 Trovare tag non corrispondenti 
 Trovare numeri non corrispondenti 
 Trovare URL non corrispondenti 
 Trovare caratteri alfanumerici non corrispondenti 
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 Trovare simboli non abbinati (p. es. parentesi, parentesi quadre o 
parentesi graffe non abbinate) 

 Trovare virgolette non abbinate 
 Trovare doppi spazi 
 Trovare parole ripetute 
 Trovare parole MAIUSCOLE nel testo di partenza senza una 

corrispondenza nel testo di arrivo e parole MAIUSCOLE nel testo di 
arrivo senza una corrispondenza nel testo di partenza 

 Trovare parole CamelCase nel testo di partenza senza una 
corrispondenza nel testo di arrivo e parole CamelCase nel testo di 
arrivo senza una corrispondenza nel testo di partenza  

 Trovare una mancata corrispondenza di termini rispetto a un elenco di 
termini chiave 

 Eseguire liste di controllo definite dall’utente. 
 Eseguire il controllo ortografico delle traduzioni (richiede il 

download del dizionario della lingua richiesta selezionando Tools-> 
Spell-Checking Dictionaries) 

Le liste di controllo sono ricerche definite dall’utente che possono essere 
eseguite in modalità batch sulla traduzione in corso. Ad esempio, con le 
liste di controllo è possibile effettuare ricerche di parole “da evitare” o 
ricerche degli errori più comuni commessi dai traduttori. 
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Installazione e 
disinstallazione di ApSIC 
Xbench 

Installazione di ApSIC 
Xbench 

ApSIC Xbench 3.0 è disponibile nelle versioni a 32 e a 64 bit. La 
versione a 32 bit può essere installata su computer Windows a 32 e a 64 
bit. La versione a 64 bit può essere installata solo su computer Windows 
a 64 bit. ApSIC Xbench supporta Windows XP, Windows Vista, 
Windows 7 e Windows 8. Supporta inoltre Windows 2003 e Windows 
2008. 

Per installare ApSIC Xbench, procedere come segue: 

Avviare il programma eseguibile d’installazione (ad esempio, 
Setup.Xbench.x64.3.0.1080.exe). Viene visualizzata la schermata iniziale 
del programma d’installazione. 

 
Fare clic su Next. Viene visualizzata la finestra della licenza. Si prega di 
leggere attentamente le informazioni contenute per assicurarsi di 
accettare i termini della licenza. 

Per accettare i termini della licenza, fare clic su I Agree. Per non 
accettare i termini della licenza fare clic su Cancel. 

C A P I T O L O  1  
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Cambiare la cartella di destinazione se necessario e fare clic su Install 
per continuare 

I file vengono copiati nella cartella selezionata e viene visualizzata la 
finestra seguente. 

 
Fare clic su Finish per chiudere la finestra e iniziare a utilizzare ApSIC 
Xbench. 

Nel percorso Start->Programmi->ApSIC Tools->Xbench viene creato 
un collegamento per il file eseguibile di ApSIC Xbench e per la 
documentazione. 
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Disinstallazione di ApSIC 
Xbench 

Per disinstallare ApSIC Xbench, procedere come segue: 

1 Selezionare Start->Impostazioni->Pannello di controllo sulla barra 
delle attività di Windows. Aprire il Pannello di controllo e selezionare 
l’icona Programmi e funzionalità. 

2 Cercare nell’elenco ApSIC Xbench 3.0 e fare clic sul pulsante 
Disinstalla/Cambia. 

3 Scegliere Sì quando viene visualizzato il messaggio di conferma. 

Installazione automatica 
È possibile eseguire un’installazione automatica di ApSIC Xbench 
utilizzando la funzione /S dalla riga di comando. 
c:\>Setup.Xbench.x64.3.0.exe /S 

Se si desidera specificare una directory di installazione diversa, è 
possibile farlo utilizzando la funzione /D. 
c:\>Setup.Xbench.x64.3.0.exe /S 
/D=[install_directory_path] 

Tenere presente che le funzioni /S /D applicano la distinzione tra 
minuscole e maiuscole 
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Avvio e chiusura di ApSIC 
Xbench 

ApSIC Xbench è un’applicazione che una volta avviata deve essere 
appositamente chiusa se non è più utilizzata. Di solito occorre caricare il 
progetto di riferimento per effettuare ricerche sulla terminologia mentre si 
effettua la traduzione e lasciare l’applicazione in background fino a 
quando la traduzione non è terminata. La chiusura della finestra di ApSIC 
Xbench non ne interrompe l’esecuzione e l’applicazione rimane in attesa 
della prossima query con la combinazione di tasti Ctrl+Alt+Insert. 

Avvio di ApSIC Xbench 
Per avviare ApSIC Xbench procedere in uno dei modi seguenti: 

 Scegliere Start->Programmi->ApSIC Tools->Xbench sulla barra 
delle attività di Windows. 

 Fare doppio clic sull’icona di un progetto di ApSIC Xbench 
precedentemente creato (con estensione .xbp). 

Chiusura di ApSIC 
Xbench 

Per chiudere l’applicazione ApSIC Xbench, sono disponibili le seguenti 
opzioni: 

 Fare clic con il pulsante destro del mouse sull’icona ApSIC Xbench 
(una gemma rosa) dalla barra delle applicazioni e selezionare Shut 
Down Xbench. 

 • Nel menu Project, fare clic su Shut Down Xbench. 

 
 

C A P I T O L O  2  
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Registrazione di ApSIC 
Xbench 

Il sistema di licenze di ApSIC Xbench richiede agli utenti di eseguire 
l’accesso con il proprio indirizzo e-mail. Al primo avvio di Xbench, 
apparirà una finestra di dialogo Sign In. 

 
Se non si dispone ancora di un account Xbench, sarà necessario 
registrarsi per crearne uno. Fare clic sul collegamento Sign Up nella 
finestra Sign In per espanderla con i campi necessari per la registrazione. 

 
Digitare due volte il proprio indirizzo e-mail e la password e fare clic su 
Sign Up for Xbench. 

In pochi secondi, si riceverà un’e-mail di verifica nella propria casella 
della posta in arrivo. Aprire l’e-mail e fare clic sul collegamento Verify 
your email address. 

Ora sarà possibile registrarsi con le credenziali appena create. 
 

C A P I T O L O  3  
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In questa sezione verranno fornite informazioni sulle funzioni di ricerca 
di ApSIC Xbench. Per comprendere il funzionamento di ApSIC Xbench 
sono utili i seguenti concetti: 

Progetto: in ApSIC Xbench un progetto è una definizione di vari file con 
le relative priorità e relazioni. La prima cosa da fare in ApSIC Xbench è 
definire un progetto con la terminologia da analizzare e il modo in cui 
effettuare la ricerca. 

Traduzione in corso: con ApSIC Xbench è possibile definire un file o un 
gruppo di file come “traduzione in corso” (Ongoing Translation) e 
visualizzare le stringhe di tale file nei risultati della ricerca. È importante 
sottolineare che le funzionalità di QA possono essere eseguite solo su file 
definiti come Ongoing Translation. 

Lista di controllo: in ApSIC Xbench, una lista di controllo (checklist) è 
una serie di ricerche eseguibili in batch. 

PowerSearch: è una particolare modalità di ricerca in cui è possibile 
impostare condizioni e negazioni con operatori di tipo AND/OR sulla 
stringa di ricerca, al fine di realizzare ricerche complesse. È una 
funzionalità molto utile per le operazioni di QA. 

Espressione regolare: un’espressione regolare è una stringa di ricerca 
contenente caratteri speciali con significati particolari che forniscono un 
modo rapido e flessibile per identificare sequenze di caratteri o parole. La 
sintassi delle espressioni regolari si basa su standard condivisi. Questa è 
una delle modalità di ricerca e di QA di ApSIC Xbench. 

Caratteri jolly di Microsoft Word: con ApSIC Xbench è possibile anche 
eseguire ricerche utilizzando i caratteri jolly di Microsoft Word, che 
adottano una sintassi simile a quella delle espressioni regolari, ma 
leggermente semplificata. 

  
 

Utilizzo delle funzioni di ricerca 
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Definizione dei progetti di 
ricerca 

Il primo passo per utilizzare le potenti funzionalità di ricerca di ApSIC 
Xbench consiste nel definire il materiale di riferimento del progetto. A 
tale fine, occorre aggiungere al progetto i file e le cartelle necessarie con 
il comando Project->Properties o premendo F2. Viene visualizzata la 
finestra di dialogo Project Properties, come illustrato in basso. 

 
Fare clic sul pulsante Add per aggiungere file al proprio progetto. 

Selezionare il tipo di file da aggiungere al progetto di ApSIC Xbench: 

 

C A P I T O L O  4  
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ApSIC Xbench può gestire i seguenti tipi di file: 

 File di testo delimitato da tabulazione (*.txt, *.tsv, *.utx). Un file in cui 
ogni riga è composta da campi delimitati dal carattere di tabulazione. 
Si presuppone che il primo ed il secondo campo di un record siano 
rispettivamente il testo di partenza ed il testo di arrivo e che gli 
ulteriori campi (in qualsiasi numero) siano descrittivi. Questo formato 
supporta anche i file delimitati da tabulazione UTX. 

 File XLIFF (*.xlf, *.xlif, *.xliff, *xlz, *.mxliff, *.mqxlz). Un file conforme 
alle specifiche XLIFF. 

 Memoria TMX (*.tmx). Un file conforme alle specifiche TMX. La 
maggior parte dei software di traduzione è in grado di generare 
memorie in formato TMX con differenti livelli di conformità. 

 Glossario TBX/MARTIF (*.xml, *.tbx, *.mtf). Un file conforme alle 
specifiche TBX o MARTIF. 

 File TIPP (*.tipp). Un file conforme alle specifiche TIPP. 
 Memoria esportata da Trados (*.txt). Una memoria esportata da Trados 

in formato .txt. 
 Glossario MultiTerm 5 esportato da Trados (*.txt). Un glossario di 

MultiTerm esportato in un file .txt in cui ogni record è delimitato da 
una riga contenente due asterischi (**). 

 Glossario di Trados MultiTerm (*.xml, *.sdltb, *.mdb). Un glossario di 
MultiTerm esportato in formato XML, SDLTB o MDB. 

 File di Trados TagEditor (*.ttx). Un file .ttx di Trados. 
 File Word di Trados (*.doc, *.rtf). Un file .doc o .rtf di Trados con 

segmenti bilingui. 
 File di Trados Studio (*.sdlxliff, *.sdlproj). Un file di Trados Studio 

.sdlxliff o .sdlproj. Quando viene specificato un file di progetto di 
Trados Studio (*.sdlproj), ApSIC Xbench apre i file .sdlxilff associati 
al file di progetto per la prima coppia di lingue rilevata nel file di 
progetto. 

 Memoria di Trados Studio (*.sdltm). Una memoria di traduzione di 
Trados Studio in formato .sdltm. 

 File di memoQ. Un file XLIFF di memoQ 6 con estensione .mqxlz o 
.mqxliff o un pacchetto di consegna (*.mqout) o di ritorno 
(*.mqback) di memoQ.   

 File di SDLX (*.itd). Un file .itd di SDLX. Nota: questa opzione 
richiede la presenza di una versione di SDLX installata nel computer.  

 Memoria di SDLX (*.mdb). Un singolo file .mdb di SDLX contenente 
una memoria di traduzione. 

 Directory di STAR Transit 2.6/XV/NXT Una directory che contiene 
coppie di lingue di Transit. 

 File PO. Un file .po bilingue, generato in genere con gettext. 
 Dizionario di IBM TM/OpenTM2 (*.sgm). Un dizionario di IBM 

TranslationManager o OpenTM2 in formato SGML. Questo file 
presenta l’estensione .sgm. 

 Cartella di IBM TM/OpenTM2. Un dizionario di IBM 
TranslationManager o OpenTM2 installato nel proprio sistema. 
Questo formato può essere definito come traduzione in corso, per 
distinguere chiaramente la traduzione vecchia da quella nuova e per 
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visualizzare anche i segmenti non tradotti al fine di fare scelte più 
accurate per la terminologia nuova. 

 Cartella esportata di IBM TM/OpenTM2 (*.fxp). Una cartella di IBM 
TranslationManager o OpenTM2 esportata in formato .fxp. 

 Memoria esportata di IBM TM/OpenTM2 (*.exp). Una memoria di IBM 
TranslationManager o OpenTM2 esportata in formato .exp. 

 Memoria di Wordfast (*.txt). Una memoria di Wordfast, con estensione 
.txt. 

 Glossari di Wordfast (*.txt). Un glossario di Wordfast, con estensione 
.txt. 

 File TXML di Wordfast Pro (*.txml). Un file bilingue di Wordfast Pro, 
con estensione *.txml. 

 File di Déjà Vu X/Idiom (*.wsprj, *.dvprj, *.dvsat, *.dvpng). Un database 
di Déjà Vu o Idiom dei file di traduzione di progetto, con estensioni 
.dvprj, .dvsat, .dvpng o .wsprj. 

 Memoria di Déjà Vu X/Idiom (*.wstm, *.dvmdb). Una memoria di 
traduzione di Déjà Vu o Idiom, con estensioni .dvmdb o .wstm. 

 File RTF di Logoport (*.rtf). Un singolo file .rtf di Logoport o una 
directory contenente più file .rtf di Logoport. 

 Glossario Microsoft (*.csv). Un glossario software creato da Microsoft, 
pubblicato da Microsoft tramite MSDN e contenente tutte le stringhe 
di un’applicazione software di Microsoft. 

 Glossario di Mac OS X (*.ad, *.lg). Un glossario in formato XML di 
Apple per i propri software, disponibile gratuitamente su Internet. 

 File di Qt Linguist (*.ts). Un file nel formato di traduzione per il 
framework Qt. 

 Glossari di Passolo (*.glo). Un glossario di Passolo, con estensione 
*.glo.  

 Progetto in Transifex. Un progetto online in Transifex.  
 Remote Xbench Server. Un riferimento ad un server remoto di ApSIC 

Xbench. 

Dopo aver selezionato il tipo di file, apparirà la scheda File List, in cui è 
possibile aggiungere più elementi del tipo selezionato. In base al tipo di 
file scelto, fare clic sul pulsante Add File... o Add Folder... per 
aggiungere elementi all’elenco. 

A partire da questa fase, la sequenza delle schermate visualizzate è 
diversa a seconda del tipo di file selezionato. Seguire le istruzioni 
corrispondenti al tipo di file specifico per ottenere i passaggi necessari: 

 

Se si stanno aggiungendo gli 
elementi... 

Procedere come segue: 

File di testo delimitato da 
tabulazione, file XLIFF, 
memoria TMX, file TIPP, 
memoria esportata di Trados, file 
di Trados Tag Editor, file di 
Word di Trados, File di Trados 

1 Viene visualizzata la scheda File 
List. Fare clic su Add File o Add 
Folder per aggiungere file o cartelle 
di file del tipo selezionato. Le 
cartelle appariranno in grassetto 
nell’elenco. 
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Studio, Memoria di Trados 
Studio, file di memoQ, file 
SDLX, memoria di SDLX, file 
PO, dizionario di IBM 
TM/OpenTM2, cartella esportata 
di IBM TM/OpenTM2, memoria 
esportata di IBM TM/OpenTM2, 
memoria di Wordfast, glossario 
di Wordfast, file TXML di 
Wordfast Pro, glossario di 
Microsoft, glossario di Mac OS 
X, file di Déjà Vu X/Idiom, 
memoria di Déjà Vu/Idiom, file 
RTF di Logoport, file di Qt 
Linguist, glossario di Passolo 

2 Fare clic su Next sulla scheda File 
List per aprire la scheda Properties. 

3 Assegnare le proprietà rilevanti e 
fare clic su OK per terminare. Nota: 
se si sono aggiunte delle cartelle nel 
punto 1, fare clic su Next per aprire 
un pannello aggiuntivo in cui è 
necessario indicare se si desidera 
includere i file dello stesso tipo in 
cartelle child con la casella di 
controllo Recurse Directories. 

Directory di STAR Transit 1 Una volta apparsa la scheda File 
List, si aprirà automaticamente la 
finestra di dialogo Select 
Directory.... Scorrere fino alla 
directory contenente i file che si 
desidera caricare nel progetto di 
ApSIC Xbench. 

2 Fare clic su Next sulla scheda File 
List per aprire la scheda Properties. 

3 Assegnare le proprietà rilevanti alla 
directory e fare clic su Next per 
passare alla scheda Directory 
Settings. 

4 Nella scheda Directory Settings è 
possibile spuntare la casella di 
controllo Recurse Directories 
qualora si richieda che ApSIC 
Xbench ricerchi i file anche nelle 
directory secondarie. 

Glossario MultiTerm 5 esportato 
da Trados, Trados MultiTerm o 
TBX/MARTIF 

1 Una volta apparsa la scheda File 
List, si aprirà automaticamente la 
finestra di dialogo Add Glossary. 
Selezionare tutti i file del tipo 
corrente nella finestra. Se è 
necessario scegliere alcuni file da 
un’altra directory, quando ci si trova 
nuovamente nella scheda File List, 
fare clic sul pulsante Add File per 
riaprire la finestra Add Glossary. 

2 Fare clic su Next sulla scheda File 
List per aprire la scheda Properties. 

3 Assegnare le proprietà rilevanti al 
file e fare clic su Next per passare 
alla scheda corrispondente al 
formato del file. 

4 Selezionare la lingua di partenza e 
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di arrivo dall’elenco di lingue 
proposto e fare clic su OK al 
termine dell’operazione. 

Cartella di IBM TM/OpenTM2 1 Una volta apparsa la scheda File 
List, si aprirà automaticamente la 
finestra di dialogo Select IBM 
TM/OpenTM2 Folder. Se 
necessario, modificare l’unità 
contenente la cartella IBM TM o 
OpenTM2, quindi selezionare la 
cartella o le cartelle nell’elenco di 
cartelle che verrà visualizzato. 

2 Fare clic su Next sulla scheda File 
List per aprire la scheda Properties. 

3 Assegnare le proprietà rilevanti e 
fare clic su OK per terminare. 

Progetto in Transifex 1 Assegnare le proprietà rilevanti e 
fare clic su Next per passare alla 
scheda Transifex. 

2 Digitare lo slug di un progetto 
Transifex o incollare l’URL di un 
progetto Transifex, quindi fare clic 
su Connect. 

3 Scegliere una lingua dall’elenco di 
lingue del progetto e fare clic su 
OK al termine dell’operazione. 

Remote Xbench Server 1 Assegnare le proprietà rilevanti e 
fare clic su Next per passare alla 
scheda Remote Xbench Server. 

2 Assegnare un nome alla 
connessione e specificare l’URL di 
Xbench Server. 

Di ritorno nella finestra Project Properties, è possibile aggiungere altri 
file o directory seguendo i passaggi descritti sopra. 

Al termine, fare clic su OK sulla finestra Project Properties per tornare 
alla finestra principale di ApSIC Xbench. ApSIC Xbench caricherà i 
glossari nell’ambiente di lavoro. 

A questo punto, sul menu Project , fare clic su Save as per salvare il 
progetto appena creato nella propria directory, con altri progetti ApSIC 
Xbench. Si raccomanda di salvare i file di progetto utilizzando nomi 
intuitivi per semplificarne il riutilizzo futuro.  

Nota: al prossimo avvio di ApSIC Xbench, verrà caricato 
automaticamente l’ultimo progetto aperto, a meno che ciò non venga 
disattivato in Tools->Settings->Miscellaneous. 
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Ricerca di termini 
ApSIC Xbench dispone di un motore di ricerca molto potente. Ad 
esempio, è possibile effettuare ricerche su termini nella lingua di 
partenza, nella lingua di arrivo o su entrambe. ApSIC Xbench consente 
anche di effettuare ricerche utilizzando le espressioni regolari o i caratteri 
jolly di Microsoft Word, e di utilizzarli insieme in modalità PowerSearch. 

 
In genere, la maggior parte delle ricerche viene eseguita per termine nella 
lingua di partenza. Tuttavia, la necessità di effettuare ricerche su un 
termine non si presenta quando si è nell’interfaccia di ApSIC Xbench, 
bensì mentre si effettua la traduzione in Word, o con uno strumento di 
traduzione assistita, come Trados Translator’s Workbench, SDLX, IBM 
TranslationManager, Déjà Vu, oppure nel proprio programma di posta 
elettronica, come Microsoft Outlook. 

Per questo motivo, ApSIC Xbench è accessibile da qualsiasi applicazione 
con un’unica combinazione di tasti (Ctrl+Alt+Ins). 
Nei 5 punti successivi si descrivono le modalità di interazione con ApSIC 
Xbench. Il punto di partenza in questo caso è un documento attivo di 
Microsoft Word su cui si sta lavorando e un progetto di ApSIC Xbench 
caricato in background. 

1 In Microsoft Word, selezionare (interamente o parzialmente) il 
termine da ricercare.  

2 In Microsoft Word, premere Ctrl+Insert, quindi Ctrl+Alt+Insert per 
richiamare ApSIC Xbench. Questa azione automatica consente di 
ricercare i file caricati in ApSIC Xbench per il termine 
contrassegnato. Questa combinazione di tasti è la più importante 
quando si ricerca la terminologia con ApSIC Xbench.  

3 ApSIC Xbench mostra il risultato della query nella maniera riprodotta 
dalla figura precedente. 
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È possibile definire fino a tre aree di priorità: verde (priorità alta), 
rosso bordeaux (priorità media) e blu (priorità bassa). La colonna 
contrassegnata con il simbolo # indica il numero delle occorrenze nel 
file esaminato del termine indicato nella finestra. 
Il punto verde  di fianco al termine nella lingua di arrivo indica che 
la voce ha una corrispondenza esatta con la stringa ricercata (anche 
per i caratteri maiuscoli/minuscoli). Il punto giallo  visualizzato di 
fianco al termine nella lingua di arrivo indica che la voce ha una 
corrispondenza esatta tranne che per i caratteri maiuscoli/minuscoli. 
Ad esempio, nel caso precedente la stringa ricercata è stata 
“clipboard”, (con la c minuscola) anziché “Clipboard” ed il punto 
visualizzato è giallo anziché verde perché la stringa della query è 
diversa da quella trovata nel file. 
Quando si traduce una documentazione, questa indicazione è molto 
utile perché è possibile copiare e incollare il termine nella lingua di 
arrivo, consentendo una maggiore produttività e precisione. Qui di 
seguito è possibile vedere come sfruttare questa funzione. 

4 Per copiare negli appunti il termine nella lingua di arrivo basta 
premere il tasto Invio chiudendo così la finestra di ApSIC Xbench. 
ApSIC Xbench viene nascosto e si ritorna all’applicazione di partenza 
(in questo caso Microsoft Word). 
Nota: se non si desidera copiare nulla negli appunti, premere Esc o 
Alt+F4 per nascondere ApSIC Xbench e tornare a Microsoft Word. 

5 Se si sceglie di chiudere la finestra di ApSIC Xbench con il tasto 
Invio salvando quindi negli appunti il termine nella lingua di arrivo, è 
possibile premere Maiusc+Ins per copiarlo nel documento. 

È facile capire che, soprattutto nel campo delle traduzioni di messaggi 
software, risulta più veloce cercare e incollare piuttosto che scrivere a 
mano i messaggi; è quindi possibile aumentare contemporaneamente la 
produttività e la coerenza della traduzione. 

Suggerimento: ripetere la procedura precedente per acquisire 
dimestichezza fino a quando non diventa intuitiva. Ricercare parole che 
hanno corrispondenza esatta in modo da impadronirsi del procedimento 
per incollare. 
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Espressioni regolari e 
caratteri jolly di Microsoft 
Word 

Con ApSIC Xbench è possibile realizzare potenti ricerche utilizzando le 
espressioni regolari o i caratteri jolly di Microsoft Word. Per attivare le 
modalità di ricerca procedere come segue: 

1. Scegliere View->Search Options per mostrare il riquadro Search 
Options. 

2. Espandere il menu a discesa Search Mode e scegliere Regular 
Expressions o MS Word Wildcards. 

3. Verrà visualizzata un’icona accanto ai campi Source Term e Target 
Term, a indicare la modalità selezionata. 

Sintassi delle espressioni regolari 
Carattere o 
Espressione 

Significato Esempi 

. Qualsiasi carattere Jo.n corrisponde a John e a Joan, ma non a 
Johan. 

* 0 o più istanze del carattere 
precedente 

Joh*n corrisponde a Jon, a John e a Johhn, ma 
non corrisponde a Johan. 

Nota: nelle espressioni regolari, l’asterisco non 
segue le stesse regole dei caratteri jolly di 
Microsoft Word. Per indicare un numero 
qualsiasi di carattere occorre utilizzare la 
sequenza punto-asterisco (.*). Ad esempio, 
Joh.*n corrisponde a John, Johhn e Johan (ma 
non a Jon). 

? 0 o 1 istanza del carattere precedente Joh?n corrisponde a Jon e John, ma non a 
Johan. 

+ 1 o più ripetizioni del carattere 
precedente 

Joh+n corrisponde a John e Johhn, ma non a 
Jon o Johan. 

{m} Esattamente m ripetizioni del 
carattere precedente 

Joh{2}n corrisponde a Johhn, ma non a Jon, 
John o Johhhn. 

{m,} m o più ripetizioni del carattere 
precedente 

Joh{2,}n corrisponde a Johhn e Johhhn, ma 
non a Jon o John. 
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{,n} Da 1 a n ripetizioni del carattere 
precedente 

Joh{,2}n corrisponde a John e Johhn, ma non a 
Jon o Johhhn. 

{m,n} Da m a n ripetizioni del carattere 
precedente 

Joh{1,2}n corrisponde a John e Johhn, ma non 
a Jon o Johhhn. 

< Inizio della parola <Phon corrisponde e Phone ma non a iPhone. 

> Fine della parola hones> corrisponde a Phones ma non a Phone. 

Nota: per ricercare una parola intera, è possibile 
specificare <Phone> per ottenere Phone, ma 
non Phones o iPhone, oppure è possibile 
specificare <Phones*> per ottenere sia Phone 
che Phones, ma non iPhone o iPhones. 

^ Inizio di riga (deve trovarsi all’inizio 
dell’espressione) 

^Phone corrisponde a tutte le parole che 
iniziano con Phone. 

$ Fine di riga (deve trovarsi alla fine 
dell’espressione) 

received$ corrisponde a tutte le parole che 
finiscono con received. 

\ Carattere Escape. Il carattere 
successivo è riconosciuto come 
carattere normale. 

phone\. corrisponde a tutte le unità che 
presentano un punto dopo phone. (In questo 
caso, il punto non significa “qualsiasi” carattere 
perché è presente il simbolo di Escape.) 

% Il carattere o l’espressione 
precedente non fanno distinzione tra 
maiuscole e minuscole. Quando 
ApSIC Xbench fa distinzione tra 
caratteri maiuscoli e minuscoli, 
questa opzione permette di rendere 
parte della stringa “esente” da tale 
distinzione. 

Quando ApSIC Xbench fa distinzione tra 
maiuscole e minuscole, a% corrisponderà ad a e 
A. In modo simile, P(hone)% corrisponde a 
Phone e PHONE, ma non a phone perché in 
quest’ultimo caso la lettera p non è compresa 
nell’espressione modificata dall’operatore. 

\xnn o \xnnnn  Il carattere specificato da nn o nnnn, 
in cui nn o nnnn è un numero 
esadecimale. Se vengono specificate 
solo due cifre, si presume che sia il 
relativo equivalente Unicode \x00nn. 

\x48\x6f\x77\x64\x79\x3f e 
\x0048\x006f\x0077\x0064\x0079\x003f 
corrispondono entrambi a Howdy? 

| Operatore OR ^H|I corrisponde a tutte le frasi che iniziano con 
una H o con una I. 

( ) Operatore di parentesi per specificare 
priorità 

(^H)|I corrisponde a tutte le frasi che iniziano 
con una H o che contengono una I. 
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[set-expression] Carattere che appartiene al tipo 
definito in set-expression. Un set è 
definito da caratteri individuali (ad 
esempio, [aeiou]) e/o un insieme di 
caratteri indicati dal carattere iniziale 
e da quello finale (ad esempio, [a-
z]). 

File[0-9] corrisponde a File0, File1, File2, ... 
File9, ma non corrisponde a FileX. 

File[ABC] corrisponde a FileA, FileB e FileC, 
ma non corrisponde a FileD. 

[:special-set:] Un carattere che appartiene a una 
set-expression predefinita. In ApSIC 
Xbench sono predefiniti i seguenti 
set speciali: [:space:], [:control:], 
[:punctuation:], [:punct:], 
[:separator:], [:sep:], [:symbol:], 
[:alpha:], [:num:], [:xdigit:], 
[:alphanum:], [:letter:], [:digit:], 
[:letterdigit:], [:number:]. Il set 
speciale deve essere usato all’interno 
delle set-expression (ad esempio 
[:digit:]). I caratteri corrispondenti a 
ciascun set speciale sono indicati in 
Set speciali (a pagina 31). 

File[:digit:] corrisponde a File0, File1 o File2, 
ma non a FileA o FileB. 

File[:alpha:][:digit:] corrisponde a FileA0, 
FileB1 o FileC2, ma non a File1A o File2B. 

[^set-
expression] 

Qualsiasi carattere che non 
appartiene al tipo definito in set-
expression. 

File[^ABC] corrisponde a FileD o a FileE, ma 
non corrisponde a FileA, FileB e FileC. 

(expression)=n Assegna alla variabile n la soluzione 
dell’espressione nel segmento 
attualmente identificato. Tale 
soluzione può essere richiamata con 
l’espressione @n. 

(File[0-9])=1 definisce la variabile 1 come 
soluzione di File[0-9]. 

@n Restituisce la soluzione della 
variabile n. 

@1 nel precedente esempio restituisce File1 se 
la stringa ricercata contiene File1, File2 se 
invece contiene File2, e così via. 
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Sintassi dei caratteri jolly di Microsoft Word 
Carattere o 
Espressione 

Significato Esempi 

. Qualsiasi carattere Jo.n corrisponde a John e a Joan, ma non a 
Johan. 

* 0 o più caratteri Joh*n corrisponde a John, Johan e Johhn, ma 
non corrisponde a Jon. 

? 0 o 1 carattere Jo?n corrisponde a Jon, John e Joan, ma non a 
Johan. 

@ 1 o più ripetizioni del carattere 
precedente 

Joh@n corrisponde a John e Johhn, ma non a 
Jon o Johan. 

{m} Esattamente m ripetizioni del 
carattere precedente 

Joh{2}n corrisponde a Johhn, ma non a Jon, 
John o Johhhn. 

{m,} m o più ripetizioni del carattere 
precedente 

Joh{2,}n corrisponde a Johhn e Johhhn, ma 
non a Jon o John. 

{,n} Da 1 a n ripetizioni del carattere 
precedente 

Joh{,2}n corrisponde a John e Johhn, ma non a 
Jon o Johhhn. 

{m,n} Da m a n ripetizioni del carattere 
precedente 

Joh{1,2}n corrisponde a John e Johhn, ma non 
a Jon o Johhhn. 

< Inizio della parola <Phon corrisponde e Phone ma non a iPhone. 

> Fine della parola hones> corrisponde a Phones ma non a Phone. 

Nota: per ricercare una parola intera, è possibile 
specificare <Phone> per ottenere Phone, ma 
non Phones o iPhone, oppure è possibile 
specificare <Phones*> per ottenere sia Phone 
che Phones, ma non iPhone o iPhones. 

^ Inizio di riga (deve trovarsi all’inizio 
dell’espressione) 

^Phone corrisponde a tutte le parole che 
iniziano con Phone. 

$ Fine di riga (deve trovarsi alla fine 
dell’espressione) 

received$ corrisponde a tutte le parole che 
finiscono con received. 

\ Carattere Escape. Il carattere 
successivo è riconosciuto come 
carattere normale. 

phone\. corrisponde a tutte le unità che 
presentano un punto dopo phone. (In questo 
caso, il punto non significa “qualsiasi” carattere 
perché è presente il simbolo di Escape.) 
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\xnn o \xnnnn Il carattere specificato da nn o nnnn, 
in cui nn o nnnn è un numero 
esadecimale. Se vengono specificate 
solo due cifre, si presume che sia il 
relativo equivalente Unicode \x00nn. 

\x48\x6f\x77\x64\x79\x3f e 
\x0048\x006f\x0077\x0064\x0079\x003f 
corrispondono entrambi a Howdy? 

| Operatore OR ^H|I corrisponde a tutte le frasi che iniziano con 
una H o con una I. 

( ) Operatore di parentesi per specificare 
priorità 

(^H)|I corrisponde a tutte le frasi che iniziano 
con una H o che contengono una I. 

[set-expression] Carattere che appartiene al tipo 
definito in set-expression. Un set è 
definito da caratteri individuali (ad 
esempio, [aeiou]) e/o un insieme di 
caratteri indicati dal carattere iniziale 
e da quello finale (ad esempio, [a-
z]). 

File[0-9] corrisponde a File0, File1, File2, ... 
File9, ma non corrisponde a FileX. 

File[ABC] corrisponde a FileA, FileB e FileC, 
ma non corrisponde a FileD. 

[:special-set:] Un carattere che appartiene a una 
set-expression predefinita. In ApSIC 
Xbench sono predefiniti i seguenti 
set speciali: [:space:], [:control:], 
[:punctuation:], [:punct:], 
[:separator:], [:sep:], [:symbol:], 
[:alpha:], [:num:], [:xdigit:], 
[:alphanum:], [:letter:], [:digit:], 
[:letterdigit:], [:number:]. Il set 
speciale deve essere usato all’interno 
delle set-expression (ad esempio 
[:digit:]). I caratteri corrispondenti a 
ciascun set speciale sono indicati in 
Set speciali (a pagina 31). 

File[:digit:] corrisponde a File0, File1 o File2, 
ma non a FileA o FileB. 

File[:alpha:][:digit:] corrisponde a FileA0, 
FileB1 o FileC2, ma non a File1A o File2B. 

[!set-expression] Qualsiasi carattere che non 
appartiene al tipo definito in set-
expression. 

File[!ABC] corrisponde a FileD o FileE, ma 
non corrisponde a FileA, FileB e FileC. 

(expression)=n Assegna alla variabile n la soluzione 
dell’espressione nel segmento 
attualmente identificato. La 
soluzione può essere richiamata con 
l’espressione \n. 

(File[0-9])=1 definisce la variabile 1 come 
soluzione di File[0-9]. 

\n Restituisce la soluzione della 
variabile n. 

\1 nel precedente esempio restituisce File1 se la 
stringa ricercata contiene File1, File2 se invece 
contiene File2, e così via. 
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Set speciali 
La tabella seguente mostra i caratteri corrispondenti ai set speciali 
utilizzabili nelle espressioni regolari e nei caratteri jolly di Microsoft 
Word: 

Set speciale Caratteristiche corrispondenti al set speciale 

[:alpha:] Uno qualsiasi dei caratteri considerati come alfabetici 
dal sistema operativo in base alla pagina con i codici 
ANSI correnti. 

[:alphanum:] Uno qualsiasi dei caratteri considerati come 
alfanumerici dal sistema operativo in base alla pagina 
con i codici ANSI correnti. 

[:control:] Caratteri all’interno dell’intervallo esadecimale 
0x00-0x19. 

[:digit:] Qualsiasi cifra compresa tra ‘0’ e ‘9’. 

[:letter:] Sinonimo di [:alpha:]. 

[:letterdigit:] Sinonimo di [:alphanumeric:]. 

[:num:], [:number:] Qualsiasi cifra compresa tra ‘0’ e ‘9’ oltre ai seguenti 
numeri espressi in apice e in frazione: ’¹’, ’²’, ’³’, ’¼’, 
’½’, ’¾’ 

[:punct:], [:punctuation:] Uno qualsiasi dei seguenti caratteri: ! " # % & ’ ( ) * , 
- . / : ; ? @ [ \ ] _ { } ¡ «  · » ¿ 

[:sep:], [:separator:] Spazio (Hex 0x20) e spazio unificatore (Hex 0xA0) 

[:symbol:] Uno qualsiasi dei seguenti caratteri: $ + <=> ^ ` | ~ ¢ 
£ ¤ ¥ ¦ § ¨ © ¬ ® ¯ ° ± ´ ¶ ¸ × ÷ 

[:space:] Spazio (Hex 0x20), tabulazioni e ritorni a capo 
nell’intervallo Hex 0x09-0x0C, oltre a Hex 0x85 e 
Hex 0xA0. 

[:xdigit:] Qualsiasi cifra esadecimale da ‘0’ a ‘9’ e da ‘a’ a ‘f’ 
(o da ‘A’ a ‘F’). 
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Funzionalità avanzate 
ApSIC Xbench è dotato di funzionalità avanzate molto utili in caso di 
specifiche esigenze, descritte nelle sezioni successive. 

Funzione PowerSearch 
È possibile utilizzare la combinazione di tasti Ctrl+P (PowerSearch) per 
effettuare ricerche con criteri più complessi. Tramite la funzione 
PowerSearch è possibile ricercare elementi che:  

 Contengono due o più stringhe, ma non necessariamente consecutive. 
 Non contengono una determinata stringa. 
 Contengono una stringa oppure un’altra 
 Una combinazione qualsiasi delle precedenti ricerche. 

Esempi: 

L’espressione... ...permette le ricerche seguenti: 

stringa1 stringa2 Trova tutte le voci che contengono 
“stringa1” e “stringa2” 

stringa1 or stringa2 Trova tutte le voci che contengono 
“stringa1” o “stringa2” 

stringa1 -stringa2 Trova tutte le voci che contengono 
“stringa1” ma che non contengono 
“stringa2” 

stringa1 -"string2 with 
embedded blanks" 

Trova tutte le voci che contengono 
“stringa1” ma che non contengono 
“stringa2 with embedded blanks” (stringa 2 
con spazi inclusi) 

In espressioni ancora più complesse con combinazioni di stringhe, 
operatori booleani e relazioni, è possibile utilizzare le parentesi per 
indicare la priorità. 

In modalità PowerSearch, occorre utilizzare le virgolette doppie come 
delimitatori se l’espressione contiene spazi vuoti o parentesi. Se 
l’espressione stessa da ricercare contiene al suo interno le virgolette 
doppie, occorre isolarle utilizzando una sequenza di due doppie 
virgolette. 

Nota: se una delle parole da ricercare in modalità PowerSearch è la parola 
“or”, occorre scrivere la parola “or” tra virgolette per evitare che venga 
riconosciuta come operatore. 
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PowerSearch può essere utilizzato in una qualsiasi delle seguenti 
modalità: Semplice, Espressioni regolari e caratteri jolly di Microsoft 
Word. 

Ingrandimento 
ApSIC Xbench presenta 3 tipi di ingrandimento: 

 Zoom to Level 
 Zoom to Glossary 
 Zoom to File 

Come precedentemente accennato, con ApSIC Xbench è possibile 
visualizzare l’immagine del termine più rilevante per ogni livello di 
priorità in un’unica modalità di visualizzazione. In questa maniera è 
possibile analizzare la possibile presenza di incongruenze o anche di 
significati diversi e prendere decisioni più accurate sulla scelta dei 
termini. 

È tuttavia possibile che occorra visualizzare ulteriori occorrenze (o tutte) 
di un livello specifico per effettuare un’analisi più approfondita di un 
termine. 

A tale fine, fare doppio clic sulla parte centrale della finestra del livello di 
priorità che si vuole ingrandire per ottenere l’elenco completo di tutte le 
occorrenze del termine ricercato. Lo sfondo diverrà di colore verde 
segnalando che si è in modalità ingrandita. 

Per uscire dalla modalità ingrandita, fare nuovamente doppio clic sulla 
parte centrale della finestra. 

Ricerca inversa 
In ApSIC Xbench è presente anche un metodo basato sulla tastiera per 
effettuare la ricerca in base alla colonna target piuttosto che alla colonna 
source. La combinazione di tasti predefinita per questa funzionalità è 
Ctrl+Alt+Backspace. 

Ciò equivale a lasciare il campo Source Term vuoto e riempire il campo 
Target Term. 

Questo ricerca può essere opportuna, ad esempio, se si vuole utilizzare un 
nuovo termine nella propria lingua e si vuole essere certi che tale termine 
non sia già stato utilizzato, al fine di evitare potenziali conflitti futuri 
nella terminologia chiave del progetto. 
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Filtro dell’ambito di ricerca 
Il riquadro Search Options (View->Search Options) consente di 
restringere l’ambito di ricerca. Le opzioni disponibili di filtro sono le 
seguenti: 

 Only New Segments: mostra solo i match nei segmenti non al 100%. 
 Only 100% Matches: mostra solo i match nei segmenti che 

corrispondono a match al 100%. 
 Only Ongoing Translation: mostra solo i match nei file definiti 

come traduzione in corso nelle proprietà del progetto. 
 Exclude ICE Segments: esclude gli In-Context Exact Match (detti 

anche match al 101% o Perfect Match) dai risultati della ricerca. 

Visualizzazione del contesto 
Se si fa clic con il pulsante destro del mouse su un risultato di ricerca e si 
sceglie la voce di menu See Context, verranno visualizzate le dieci unità 
rilevate fisicamente nel file prima e dopo la voce corrente. 

Esclusione dei tag 
Se i match della ricerca all’interno di tag devono essere esclusi dai 
risultati, è possibile spuntare la casella di controllo Ignore Tags nel 
riquadro Search Options.  

Modifica del documento 
originale 

La voce di menu Tools->Edit Source, eseguibile anche con i tasti di 
scelta rapida Ctrl+E, consente di aprire il file di partenza a cui appartiene 
la voce attualmente selezionata. Ciò si rivela molto utile per correggere 
rapidamente un errore terminologico riscontrato nella traduzione in corso. 
Se il file di partenza è un file .itd di SDLX, un file .ttx di Trados Tag 
Editor, un file di Word di Trados, un file di memoQ, un file di Trados 
Studio o una cartella di IBM Translation Manager, ApSIC Xbench passa 
direttamente al segmento che contiene il testo. Per Transifex, apre una 
finestra in cui è possibile digitare la propria correzione e inviarla a 
Transifex.  

Per utilizzare questa funzionalità con IBM Translation Manager, occorre 
assicurarsi che il software sia aperto e che non ci siano documenti 
attualmente in fase di modifica. 



 

36 Utilizzo di ApSIC Xbench  
 

È anche disponibile il posizionamento di riga per i file in formato .txt e 
per le memorie esportate da Trados, ma le impostazioni dell’editor di 
testo devono essere configurate tramite il comando Tools->Settings-
>Text Editor. Per esempio, per configurare TextPad 4 per il 
posizionamento di riga, occorre selezionare il file eseguibile Text Pad e 
fornire le seguenti specifiche nell’apposito campo Command-Line 
Parameters: $filename($line,$column). In modo simile, per configurare 
Notepad++, selezionare il relativo file eseguibile e specificare quanto 
segue in Command-Line Parameters: $filename -n$line. Altri editor di 
testo richiedono valori differenti in questo campo. Si prega di riferirsi alla 
documentazione dell’editor di testo per tali valori. 

Con ApSIC Xbench è anche possibile eseguire il posizionamento di 
segmento per il formato TMX, ma nel campo Tools->Settings->TMX 
Editor deve essere configurato l’editor TMX. Per esempio, per 
configurare OKAPI Olifant per il posizionamento di segmenti, occorre 
selezionare il file eseguibile Olifant e fornire le seguenti specifiche 
nell’apposito campo in Command-Line Parameters: $Filename 
row=$Segment col=trg edit=yes. Altri editor TMX richiedono valori 
differenti in questo campo. Si prega di riferirsi alla documentazione 
dell’editor TMX per tali valori.  

In questa maniera è possibile impiegare ApSIC Xbench come strumento 
utile ed efficiente per effettuare modifiche generali nella terminologia in 
tali formati. Per annullare i cambiamenti effettuati, è possibile ricaricare 
il progetto ApSIC Xbench con il comando Project->Reload o View-
>Refresh. 

Modelli di ricerca 
I modelli di ricerca consistono in ricerche predefinite da selezionare o da 
eseguire. Per utilizzare un modello di ricerca, fare clic su Search 
Templates... nel riquadro Search Options e scegliere la ricerca 
nell’elenco. Nel campo Template Source, è possibile scegliere tra 
Sample Search Templates e Project Checklist. Fare clic su Search per 
eseguire direttamente la ricerca selezionata o fare clic su Choose per 
aprire la definizione del modello di ricerca nei campi Source Term e 
Target Term. 
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Modifica del layout dei 
campi di ricerca 

È possibile passare da un layout verticale a un layout orizzontale per i 
campi Source Term e Target Term nella scheda Search. Nel layout 
orizzontale, il campo Target Term appare accanto al campo Source 
Term e richiede meno spazio per il riquadro, in modo da fornire più 
spazio per i risultati di ricerca. Nel layout verticale, il campo Target 
Term appare sotto il campo Source Term e i campi risultano dunque 
molto più ampi.  

Per scorrere tra il layout verticale a quello orizzontale, alzare o abbassare 
il bordo inferiore del riquadro Source/Target, in modo da restringerlo o 
da espanderlo. 
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Esportazione degli 
elementi 

In ApSIC Xbench è possibile esportare elementi del progetto nei formati 
seguenti: 

 File TMX 
 File di testo delimitato da tabulazione 
 File Excel 

Per esportare il contenuto di un progetto selezionare il comando Tools-> 
Export Items. Viene visualizzata la seguente finestra di dialogo: 

 
Da questa finestra è possibile esportare tutti gli elementi di un progetto, 
tutti gli elementi della query attiva, solo gli elementi visualizzati di una 
query attiva (ad esempio se si è in modalità overview, è possibile 
visualizzare solo alcuni elementi in ogni livello di priorità), oppure tutti 
gli elementi di un glossario appartenente al progetto. 

È possibile eliminare tutte le ripetizioni nei dati esportati (le ripetizioni 
sono costituite da elementi che hanno esattamente gli stessi valori nel 
campo source e target) riducendo le dimensioni del file prodotto. È 
inoltre possibile escludere dalla ricerca i segmenti ICE (match al 100% 
con corrispondenza di contesto). 

Si può infine scegliere di esportare solamente gli elementi non tradotti (ad 
esempio per agevolare il ricorso a un sistema di machine translation) 
oppure esportare solamente gli elementi tradotti. Se si sceglie di esportare 
solamente gli elementi tradotti, è anche possibile specificare se esportare 
solo gli elementi pretradotti (ossia elementi ottenuti da una memoria di 
traduzione) o solo gli elementi recentemente tradotti. 

Quando si esporta un file .txt, è possibile aggiungere un’intestazione di 
riga.  
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Quando si esporta un file TMX possono essere specificate le 
impostazioni locali per le lingue di partenza e di arrivo. È possibile 
inserire in tali campi qualsiasi valore. Se non si ricorda il codice delle 
impostazioni locali, è possibile selezionare il pulsante puntini di 
sospensione (…) per aprire una finestra di guida in cui inserire la lingua e 
il paese.  

 
Se di solito si lavora con un limitato numero di file, è possibile fare clic 
sul pulsante con la freccia nella casella combinata per aprire una elenco 
di lingue ridotto contenente solo le lingue recentemente usate. 
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Utilizzo delle traduzioni in 
corso (ongoing 
translation) 

In ApSIC Xbench è anche possibile definire un file come traduzione in 
corso (ongoing translation) nella finestra Project Properties. 

Per impostazione predefinita, una volta aggiunti al progetto di ApSIC 
Xbench, i seguenti tipi di file presentano la casella Ongoing translation 
attiva: 

 XLIFF 
 Trados TagEditor 
 Trados Word 
 Trados Studio 
 memoQ 
 SDLX. Nota: questa opzione richiede la presenza di una versione di 

SDLX installata nel computer.  
 STAR Transit 2.6/XV/NXT 
 PO 
 Cartelle di IBM TM 
 Cartelle di OpenTM2 
 Wordfast TXML 
 Déjà Vu/Idiom 
 Logoport RTF 
 Qt Linguist 
 Progetto in Transifex 

Quando si definisce un file o una cartella come ongoing translation, 
vengono attivate le due funzionalità seguenti: 

 Le traduzioni identificate come nuove (non match 100%) vengono 
contrassegnate con un puntino rosso ( ). Le traduzioni che 
rappresentano match al 100% nella traduzione in corso vengono 
contrassegnate con un puntino rosso vuoto ( ). Con questi simboli è 
possibile distinguere un termine introdotto da uno già presente nella 
memoria di traduzione attiva. In questo modo è possibile effettuare 
scelte terminologiche, se ad esempio si ricerca un termine nella 
traduzione e si vuole essere sicuri di non averlo utilizzato 
precedentemente nella memoria di traduzione ufficiale impiegata 
nella pretraduzione del progetto. 

 I segmenti non tradotti vengono visualizzati dopo i segmenti tradotti. 
Ciò si rivela particolarmente utile per decidere la terminologia da 
adottare per una nuova voce perché si possono vedere tutte le future 
occorrenze del termine nella traduzione. In questo modo è possibile 
verificare se il termine scelto si adatta bene in tutte le occorrenze 
della traduzione in corso. 
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Nota: i glossari definiti come traduzione in corso (di solito uno per ogni 
progetto, ma possono anche essere più di uno) vengono visualizzati in 
grassetto nella finestra Project Properties. 

Inoltre i file definiti come traduzioni in corso possono essere analizzati 
dalle potenti funzionalità di QA di ApSIC Xbench. 
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Termini chiave  
(Key Terms) 

Con ApSIC Xbench è possibile definire uno o più file come Termini 
chiave (Key Terms). A tale fine, attivare la casella di controllo Key 
Terms nell’elenco dei glossari della finestra Project Properties. Verrà 
visualizzata una stella verde di fianco alla voce del glossario, come nella 
figura sottostante, ad indicare che il glossario appartiene alla categoria 
“Key Terms”. 

 
Se un file è definito come Key Term, gli elementi contenuti sono 
visualizzati con una stella nella parte superiore dei risultati. Il colore della 
stella indica che il key term è una corrispondenza esatta (stella verde ), 
o una corrispondenza esatta tranne per i caratteri maiuscolo/minuscolo 
(stella gialla ), oppure se il testo ricercato è contenuto nell’elemento 
key term (stella vuota ). 

Il seguente esempio mostra gli elementi “clipboard” e “Clipboard 
Viewer” contrassegnati come “Key Terms”: 
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Nel precedente esempio, la stella piena verde per l’elemento “clipboard” 
indica che l’elemento è una corrispondenza esatta. La stella vuota per 
l’elemento “Clipboard viewer” indica che il termine ricercato è parte di 
un key term. 

Anche la funzionalità di QA utilizza i Key Term di progetto verificando 
se sono stati utilizzati nella traduzione in corso. 
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ApSIC Xbench dispone di funzionalità di Quality Assurance (QA) per 
svolgere controlli avanzati sui file definiti come ongoing translation. Le 
funzioni di QA ricercano segmenti con i seguenti possibili problemi: 

 Segmenti non tradotti 
 Segmenti con lo stesso testo di partenza ma con testo di arrivo 

differente 
 Segmenti con lo stesso testo di arrivo ma con testo di partenza 

differente 
 Segmenti in cui il testo di arrivo corrisponde al testo di partenza 
 Segmenti con mancate corrispondenze nei tag 
 Segmenti con mancate corrispondenze nei numeri 
 Segmenti con mancate corrispondenze negli URL 
 Segmenti con mancate corrispondenze alfanumeriche 
 Segmenti con simboli non abbinati (p. es. parentesi, parentesi quadre 

o parentesi graffe non abbinate) 
 Segmenti con virgolette non abbinate 
 Segmenti con doppi spazi 
 Segmenti con parole completamente in MAIUSCOLO non 

corrispondenti tra testo di partenza e di arrivo 
 Segmenti con parole completamente in CamelCase non 

corrispondenti tra testo di partenza e di arrivo  
 Segmenti con parole chiave di progetto non rispettate 
 Segmenti che corrispondono ai criteri di ricerca impostati nella 

Project Checklist o nella Personal Checklist. Consultare il capitolo 
Gestione delle liste di controllo per ulteriori informazioni su questa 
funzione. 

 Se sono stati installati dei dizionari utilizzando l’opzione Tools-> 
Spell-Checking Dictionaries, segmenti con errori ortografici.  

  

Le funzioni di Quality Assurance sono accessibili dalla scheda QA nella 
finestra principale. La scheda QA può eseguire le seguenti funzioni: 

Utilizzo delle funzionalità di Qualità 
Assurance 
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Effettuare tutti i controlli selezionati nei riquadri Check Group e  List of 
Checks premendo il pulsante Check Ongoing Translation. Per 
impostazione predefinita sono attivati tutti i controlli disponibili, tranne 
Target same as Source. 

 Eseguire solo le ricerche definite nelle Project Checklist facendo clic 
su Run Project Checklists. 

 Eseguire solo le ricerche definite nelle Personal Checklist correnti 
facendo clic su Run Personal Checklists. Per modificare le Personal 
Checklist attive, scegliere Tools->Manage Checklists. 

 Esportare i risultati del QA visualizzati facendo clic con il pulsante 
destro del mouse e selezionando Export QA Results nei seguenti 
formati: HTML, testo delimitato da tabulazione, Excel o XML. 

Nota: si segnala che la licenza di ApSIC Xbench non permette la 
rimozione della scritta di riconoscimento visualizzata sulla parte destra 
all’inizio del report di QA esportato. Sono stati fatti tentativi per rendere 
meno visibile l’informazione sulla provenienza allo scopo di evitare il 
passaparola o altre modalità più invadenti di promozione del software tra 
i colleghi.  

I risultati sono visualizzati nella finestra principale della scheda QA. Per 
alcuni formati di file, è possibile aprire direttamente il file da ApSIC 
Xbench nel segmento mostrato in modo da correggerlo selezionando 
Tools->Edit Source o premendo Ctrl+E. 

È possibile limitare il numero delle stringhe analizzate dal processo di 
QA selezionando le caselle di controllo Only New Segments, Only 
100% Matches, o Exclude ICE Segments.  

È possibile distinguere i caratteri maiuscolo/minuscolo nel controllo di 
coerenza selezionando la casella di controllo Case-sensitive 
Inconsistencies. 

È possibile ignorare il contenuto dei tag all’interno dei segmenti per il 
controllo QA scegliendo Ignore Tags. Ciò consentirà di rilevare 
incoerenze che presentano lo stesso testo di partenza o di arrivo, eccetto 
per gli inline tag. 

Questa finestra consente di contrassegnare un errore facendo clic con il 
pulsante destro del mouse su di esso e scegliendo Mark/Unmark Issue. 
È quindi possibile decidere di mostrare o nascondere gli errori utilizzando 
i pulsanti di opzione Show Marked o Hide Marked sotto Filter Issues, 
al fine di limitare il numero di errori visualizzati. Ad esempio, per 
ignorare rapidamente e nascondere i falsi allarmi dall’elenco di risultati, 
si consiglia di scegliere Hide Marked per poi contrassegnare gli errori 
mentre si esamina l’elenco.  

Nota: il comando Export QA Results esporta solo gli errori visualizzati 
(non gli errori nascosti). 
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Gestione delle liste di 
controllo 

Le liste di controllo (Checklist) in ApSIC Xbench sono una funzione 
molto utile di Quality Assurance (QA). Generate dal motore di ricerca di 
ApSIC Xbench, le liste di controllo rappresentano un insieme di ricerche 
che possono essere eseguite in modalità batch per individuare segmenti 
con problemi. Di solito è possibile inserire nelle liste di controllo errori 
comuni, quali ad esempio l’utilizzo di termini o espressioni non 
ammesse. È buona prassi inserire il feedback dei clienti nelle liste di 
controllo per accertarsi di non trascurare le segnalazioni ricevute nelle 
successive consegne di traduzioni. 

Nella scheda QA della finestra principale, è possibile eseguire le liste di 
controllo su tutti i file definiti come ongoing translation nel progetto di 
ApSIC Xbench. 

Poiché le liste di controllo sono generate dal motore di ricerca di ApSIC 
Xbench, si può aggiungere qualsiasi elemento che può essere oggetto di 
ricerca in ApSIC Xbench. In realtà, un modo pratico per inserire una 
ricerca in una lista di controllo consiste nell’effettuare prima la ricerca 
nella scheda Project e successivamente fare clic su Add Last Search to 
Checklist nel riquadro Search Options della finestra principale. 

Sono presenti due tipi di liste di controllo: la Project Checklist e la 
Personal Checklist. 

La Project Checklist viene salvata con il file del progetto ApSIC Xbench 
(con l’estensione .xbp) e normalmente contiene i controlli specifici del 
progetto, come il controllo sull’errata traduzione di alcune parole da non 
tradurre.  

La Personal Checklist non viene salvata nel file del progetto di ApSIC 
Xbench, bensì in un file di liste di controllo di ApSIC Xbench (con 
estensione .xbl). ApSIC Xbench tiene in memoria le ultime liste di 
controllo personali utilizzate nei vari progetti. Si possono salvare sul 
disco tutte le personal checklist che si vuole, ma è possibile caricarne solo 
una alla volta. Le Personal Checklist di solito contengono tipi di controlli 
che non sono specifici del progetto, come errori comuni di ortografia non 
rilevati dai correttori ortografici o una particolare regola grammaticale 
che è interessante verificare nei vari progetti. Sono definite 
“personalizzate” (o “personali”) perché i termini compresi in queste liste 
comprendono gli errori che un traduttore tende a fare più spesso. 

Le liste di controllo sono gestite nella finestra di dialogo Checklist 
Manager. Per aprire la scheda Checklist Manager sono disponibili i 
seguenti metodi: 

 Scegliere View->Checklist Manager. 
 Fare clic sull’icona Checklist Manager della barra degli strumenti. 
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Checklist Manager consente di utilizzare le Project Checklist e le 
Personal Checklist. 

 
In Checklist Manager è possibile creare nuove Personal Checklist 
scegliendo Checklist->New quando il cursore viene posizionato su 
Personal Checklists nell’albero di navigazione. È inoltre possibile 
aggiungere una lista di controllo esistente con Checklist->Add. Tutte le 
liste di controllo personali elencate sotto Personal Checklists verranno 
eseguite facendo clic su Run Personal Checklists o Check Ongoing 
Translation sulla scheda QA. 

La lista di controllo <Project> è archiviata nel file di progetto ApSIC 
Xbench (estensione .xbp) e non può essere rimossa dal gruppo Project 
Checklists nell’albero di navigazione. È possibile aggiungere ulteriori 
liste di controllo al gruppo Project Checklists, che verrà eseguito 
facendo clic su Run Project Checklists o Check Ongoing Translation 
sulla scheda QA. Le voci in tali liste di controllo di progetto aggiuntive 
non vengono salvate nel file di progetto di ApSIC Xbench stesso, tuttavia 
diventano collegate al processo, pertanto la prossima volta che si aprirà il 
file di progetto di ApSIC Xbench, qualsiasi lista di controllo collegata 
apparirà anch’essa qui. 

Le voci nella lista di controllo selezionata sull’albero di navigazione 
vengono mostrate sul corpo della finestra. È possibile ordinare i risultati 
in base a una qualsiasi delle colonne. Per disattivare una singola voce, 
fare clic con il pulsante destro del mouse su di essa e scegliere Disable. 

Tenere presente che lo stato disattivato viene salvato su disco, pertanto la 
prossima volta che si aprirà la stessa lista di controllo la voce resterà 
disattivata. 

È possibile testare la lista di controllo selezionata rispetto al progetto 
caricato facendo clic con il pulsante destro del mouse su una voce della 
lista di controllo e scegliendo Test. Tale azione eseguirà una ricerca con 
le impostazioni delle voci della lista di controllo nella scheda Search, in 
modo da poter visualizzare se i risultati di ricerca restituiti corrispondono 
al comportamento previsto. 

Quando si fa clic sull’intestazione di una colonna, la lista viene ordinata 
per tale colonna alfabeticamente. Facendo clic sull’intestazione di una 
colonna una seconda volta, la lista viene ordinata dall’alto in basso. Se si 
digita una sequenza di caratteri, la colonna corrente verrà ricercata in 
base alla sequenza di caratteri digitata. 

È possibile aggiungere o modificare le singole voci della lista di 
controllo. I campi disponibili sono gli stessi che possono essere 
specificati nel riquadro Search Options della scheda Search. 
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In aggiunta, è possibile specificare una categoria per la voce della lista di 
controllo contenuta nella casella combo Category. Qui è possibile 
specificare qualsiasi nome di categoria. Se si desidera utilizzare un nome 
di categoria precedentemente definito, è possibile espandere la casella 
combo facendo clic sul pulsante freccia e scegliendolo dall’elenco. Se si 
sono creati dei nomi di categoria, sarà possibile eseguire selettivamente 
set secondari di categorie quando si esegue un progetto o una lista di 
controllo personale dalla scheda QA utilizzando i pulsanti Run Project 
Checklists o Run Personal Checklists. 

È inoltre possibile definire relazioni ereditarie tra le liste di controllo. Se 
una lista di controllo eredita da un’altra, tutte le relative voci vengono 
ereditate. È possibile ereditare da più liste di controllo. 

Per ereditare una lista di controllo, effettuare le seguenti operazioni. 

1. Fare clic sul pulsante Inheritance, quindi sul pulsante destro del 
mouse sulla lista di voci ereditate apparse, infine scegliere Add. 

2. Digitare un nome per la lista di controllo ereditata e scegliere il nome 
del file che la contiene. Il nome specificato qui non deve corrispondere 
necessariamente al nome di visualizzazione della lista di controllo. 
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3. Aggiungere qualsiasi lista di controllo richiesta seguendo i punti 1 e 2. 
La finestra di dialogo mostrerà le voci ereditate con l’icona . È 
possibile ignorare gli elementi ereditati, ma non modificarli né eliminarli. 

 
Una volta impostata una relazione di eredità, verrà ereditata anche 
qualsiasi modifica o aggiunta effettuata alla lista di controllo parent. 

La Project Checklist viene salvata automaticamente quando si salva il 
progetto. Se si aggiungono voci alla Project Checklist e poi si cerca di 
chiudere ApSIC Xbench, apparirà un messaggio in cui si richiede di 
salvare il progetto. 

Le modifiche effettuate a tutte le liste di controllo vengono salvate 
automaticamente, eccetto la lista di controllo <Project>, che verrà 
salvata con il file di progetto Xbench .xbp.  

Se si desidera effettuare modifiche a una lista di controllo ma senza 
salvarle, è possibile creare un duplicato di una lista di controllo facendo 
clic su di essa con il pulsante destro del mouse e scegliendo Save as. 
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Esecuzione del QA da 
Esplora risorse 

ApSIC Xbench include un’estensione shell che consente di avviare una 
sessione di QA direttamente da Esplora risorse. Ciò risulta molto comodo 
quando si desidera eseguire un semplice controllo QA di uno o più file o 
di una directory. 

Per eseguire il QA da Esplora risorse: 

1 In Esplora risorse, selezionare il file o la directory di cui si desidera 
effettuare il QA. 

2 Fare clic con il pulsante destro del mouse e scegliere Run QA with 
Xbench. 

Tali azioni avvieranno ApSIC Xbench con un progetto appena creato che 
considera on-going translation tutti i file selezionati con Esplora risorse. 

Il progetto risulta ora pronto per essere sottoposto a QA. Se si desidera 
personalizzare ulteriormente il progetto ApSIC Xbench appena creato, ad 
esempio per aggiungere un file di Key Terms, è possibile farlo in 
Project->Properties. 

Il progetto creato con Esplora risorse sarà disponibile nella propria 
directory Temp di Windows. Se si desidera salvare il progetto ApSIC 
Xbench per il riutilizzo futuro, scegliere Project->Save As e assegnargli 
un nuovo nome in una posizione sul proprio computer. 
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Utilizzo del controllo 
ortografico istantaneo di 
ApSIC Xbench 

ApSIC Xbench presenta un metodo innovativo per eseguire 
istantaneamente il controllo ortografico di tutti i file in corso presenti nel 
proprio progetto. Invece di aprire e chiudere molti file e analizzarli 
lentamente con un correttore ortografico, ignorando i falsi positivi, 
ApSIC Xbench elabora tutti i file contemporaneamente, per poi 
presentare all’utente i risultati consolidati, in cui isolare i veri errori 
ortografici molto rapidamente. 

ApSIC Xbench mette a disposizione 48 dizionari ortografici basati sul 
motore Hunspell e i dizionari di Microsoft Word qualora nel dato 
computer sia installata una versione di Microsoft Word con tale pacchetto 
linguistico. Vengono contrassegnate come errori solo le parole non 
presenti in entrambi i dizionari. È possibile disattivare il controllo con il 
dizionario Microsoft Word deselezionando l’opzione Settings->Use 
Microsoft Word dictionary nella finestra ApSIC Xbench Spell 
Checker. 

I dizionari per il controllo ortografico non sono inclusi nel programma di 
installazione di ApSIC Xbench. Possono invece essere scaricati e 
installati mediante il comando Tools->Spell-Checking Dictionaries. 

 
Quando si aggiungere un dizionario ortografico, la lingua aggiunta appare 
nel gruppo Spell-checking. 
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Per includere il controllo ortografico nei controlli da effettuare, scegliere 
Spell-checking, dopodiché selezionare una lingua in List of Checks. 
Fare quindi clic su Check Ongoing Translation. 

 
La finestra che appare mostra tutti i possibili errori ortografici rilevati, 
raggruppati per termine. Scorrere l’elenco e fare doppio clic sui veri 
errori per spostare la parola nell’elenco Real Misspelling. 

Al termine dell’elenco, fare clic su OK per aggiungere i segmenti con 
veri errori ortografici al QA report principale. 

Nella finestra Spell-Checking sono contenute alcune impostazioni che 
possono contribuire a ridurre il numero di falsi positivi elencati. Per 
mostrarle, fare clic su Exclusions. 

 
Le opzioni disponibili in questo riquadro sono le seguenti: 

 Words with numbers (Parole con numeri). se spuntata, non verranno 
considerati errori parole come Pkd05 o G5HJKH7. 

 Words in mixed case with a match in source text (Parole in 
maiuscole e minuscole presenti anche nel testo di partenza). Se 
spuntata, non verranno considerati errori parole come PlantWorks se 
il termine appare anche nel testo di partenza. 

 Segments where target text matches source text (Segmenti in cui il 
testo di arrivo corrisponde al testo di partenza). Se spuntata, non verrà 
effettuato alcun controllo ortografico sui segmenti in cui il testo di 
arrivo corrisponde esattamente a quello di partenza. Se si sta già 
utilizzando il controllo QA Basic->Target same as Source, tale 
esclusione consentirà di ignorare le parole nei segmenti 
volontariamente lasciati nella lingua di partenza.  
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 Words in UPPERCASE (Parole in maiuscole). Se spuntata, questa 
opzione non effettuerà il controllo ortografico sulle parole scritte 
completamente con lettere maiuscole.  

 Words in UPPERCASE with a match in source text (Parole in 
maiuscole presenti anche nel testo di partenza). Se spuntata, questa 
opzione non effettuerà il controllo ortografico sulle parole scritte 
completamente con lettere maiuscole se le stesse identiche parole 
sono scritte nello stesso modo nel testo di partenza. Questa 
impostazione può essere utile se la propria traduzione contiene molti 
acronimi che non cambiano da una lingua all’altra.  

 Abbreviations (Abbreviazioni). Se spuntata, questa opzione ignorerà 
le abbreviazioni. 

Utilizzo degli Addendum 
Se le proprie traduzioni contengono termini specifici in base al cliente, 
come prodotti, marchi, parole chiave comuni e così via, è probabile che i 
dizionari forniti non le includano. Il controllo ortografico di ApSIC 
Xbench consente di creare uno o più Addendum per ciascun dizionario, 
in modo che sia possibile attivarli in base alle esigenze di progetto. 

Per creare un nuovo Addendum a un dizionario, eseguire questa 
operazione: 

1 Scegliere Addendums->Manage Addendums. 

 
2 Fare clic su Add. 
3 Immettere un nome per l’Addendum e fare clic su OK. 

Una volta creato, se si desidera aggiungere uno o più termini 
all’Addendum, selezionarlo nell’elenco degli errori, fare clic con il 
pulsante destro del mouse e scegliere Add to addendum: 
<addendum_name>. 

 
È possibile aggiungere tutti gli Addendum desiderati a qualsiasi 
dizionario. Gli Addendum vengono memorizzati nel percorso specificato 
da Settings->Set Addendum Folder. 
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Funzioni aggiuntive per il 
controllo ortografico 

Il controllo ortografico di ApSIC Xbench presenta alcune interessanti 
funzioni aggiuntive: 

 È possibile modificare la dimensione dei caratteri facendo clic con il 
pulsante destro del mouse sull’elenco Unknown Words, scegliendo 
Settings e infine Enlarge Font o Reduce Font. 

 È possibile copiare le parole sconosciute negli appunti facendo clic 
con il pulsante destro del mouse sull’elenco Unknown Words, 
scegliendo Export e infine Copy to Clipboard. 

 È possibile aprire Microsoft Word o Microsoft Excel mostrando un 
elenco di parole sconosciute facendo clic con il pulsante destro del 
mouse sull’elenco Unknown Words, scegliendo Export e infine 
Open in MS Word o Open in MS Excel. L’apertura in Microsoft 
Word può risultare utile, ad esempio, se si desidera eseguire il 
controllo ortografico delle restanti parole sconosciute con Microsoft 
Word. 

 Per impostazione predefinita, i veri errori ortografici vengono 
segnalati facendo doppio clic su di loro, in modo da spostarli 
nell’elenco Real Misspellings. Ciò avviene ipotizzando che gran 
parte delle parole sconosciute siano in realtà falsi positivi, come 
spesso accade durante il controllo finale di una traduzione. Tuttavia, 
se nel proprio caso specifico avviene il contrario, si può decidere di 
modificare la modalità operativa, in modo da non contrassegnare gli 
effettivi errori ortografici, ma da segnalare invece i falsi allarmi. Per 
modificare la modalità operativa, scegliere Settings->Change 
Working Mode.  
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Utilizzo del plugin ApSIC 
Xbench per SDL Trados 
Studio 2014 

Il plugin ApSIC Xbench per SDL Trados Studio 2014 consente di: 

 creare automaticamente da SDL Trados Studio 2014 un progetto 
Xbench, raccogliendo le informazioni dal proprio progetto corrente di 
SDL Trados Studio 2014 e avviando automaticamente ApSIC 
Xbench in modo da poter eseguire il QA (controllo qualità) sui file 
del progetto. 

 utilizzare da ApSIC Xbench il comando Edit Source all’interno della 
scheda Search o la scheda QA, al fine di aprire un file sdlxliff in 
SDL Trados Studio al segmento esatto attualmente selezionato in 
Xbench e nel contesto del progetto di SDL Trados Studio (con 
connessi la memoria di traduzione e il termbase). 

 
 

Prima di installare il plugin ApSIC Xbench per SDL Trados Studio 2014, 
è necessario assicurarsi che sul proprio computer siano installati i 
seguenti software: 

 SDL Trados Studio 2014 SP1. La casella Help->About SDL Trados 
Studio dovrebbe mostrare la versione 11.1.3931 o successiva. 

 ApSIC Xbench 3.0 build 1186 o successiva. 

Se non si dispone di tali versioni, scaricarle e installarle prima di 
installare il plugin. 

È possibile scaricare ApSIC Xbench 3.0 e il plugin ApSIC Xbench per 
SDL Trados Studio 2014 dalla pagina Download del sito Web 
http://www.xbench.net. Il file di installazione del plugin è adatto a 
entrambe le edizioni (a 32 e a 64 bit) di ApSIC Xbench 3.0. 
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Installazione del plugin 
Per installare correttamente il plugin, sono richiesti i privilegi di 
amministratore. Il plugin verrà installato per tutti gli utenti di SDL Trados 
Studio presenti nel computer. Dopo l’installazione del plugin sarà 
necessario avviare almeno una volta SDL Trados Studio 2014 come 
amministratore per attivare il plugin. Ciò risulta estremamente importante 
qualora si desideri installare il plugin su un Terminal Server, in quanto 
quest’ultimo potrebbe includere utenti privi dei privilegi di 
amministratore. 

Per installare il plugin, fare clic sul file 
Setup.Xbench.Plugin.Studio.3.0.n.exe contenuto nel file scaricato da 
http://www.xbench.net, quindi seguire le istruzioni della procedura 
guidata di installazione. 

Disinstallazione del plugin 
Per disinstallare il plugin ApSIC Xbench per SDL Trados Studio 2014, 
aprire il Pannello di controllo di Windows e procedere con la 
disinstallazione. 

Tenere presente che per poter disinstallare il plugin sono richiesti i 
privilegi di amministratore. 
 

http://www.xbench.net/
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Utilizzo del plugin 
Quando si avvia SDL Trados Studio con installato il plugin di ApSIC 
Xbench, la prima cosa che si noterà è la presenza di una nuova icona 
nella barra multifunzione per la vista Projects. 

 
Il plugin ApSIC Xbench installa un’icona nelle tre barre multifunzione 
seguenti: 

 La barra multifunzione Home della vista Projects 
 La barra multifunzione Home della vista Files 
 La barra multifunzione Review della vista Editor 

Tutte queste icone eseguono indistintamente la stessa azione: Run QA in 
Current Project (Esecuzione del QA per il progetto corrente). 

L’azione Run QA in Current Project attiva le seguenti operazioni: 

1 Crea un progetto ApSIC Xbench (estensione .xbp) con i seguenti 
elementi: 
 Tutti i file sdlxliff per il progetto corrente vengono caricati come 

traduzioni in corso con priorità media (colore rosso). Se il 
progetto include più di una lingua di arrivo, verrà visualizzata la 
finestra di dialogo Choose Language. 

 
 La prima memoria di traduzione basata su file con estensione 

.sdltm rilevata per la data lingua nelle impostazioni del progetto in 
SDL Trados Studio. Il plugin ApSIC Xbench analizza per prima 
cosa le impostazioni specifiche per la data lingua e, se non viene 
rilevata alcuna memoria di traduzione, procede con le 
impostazioni per tutte le lingue (All Language Pairs). Tale 
memoria di traduzione viene caricata nel progetto Xbench 
assegnandole una priorità bassa (colore blu). È possibile 
disattivare il caricamento della memoria di traduzione mediante 
ApSIC Xbench scegliendo Tools->Settings->Studio Plugin e 
deselezionando la casella di controllo Add first local translation 
memory. Nota: scegliendo All Languages nella finestra di 
dialogo Choose Language, questo file non verrà caricato nel 
progetto Xbench. 
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 Il primo termbase basato su file con estensione .sdltb o .mdb 
presente per la data lingua nelle impostazioni del progetto in SDL 
Trados Studio. Tale glossario di MultiTerm viene caricato nel 
progetto Xbench assegnandogli una priorità alta (colore verde). È 
possibile disattivare il caricamento del termbase mediante ApSIC 
Xbench scegliendo Tools->Settings->Studio Plugin e 
deselezionando la casella di controllo Add first local termbase. 
Nota: scegliendo All Languages nella finestra di dialogo Choose 
Language, questo file non verrà caricato nel progetto Xbench. 

1 Avvia ApSIC Xbench per caricare il progetto e apre la scheda QA in 
ApSIC Xbench. 

All’interno di Xbench, è possibile selezionare le impostazioni di QA 
desiderate e scegliere Check Ongoing Translation per eseguire il QA. 
Tenere presente che verranno considerati per il QA solo i file di 
traduzione in corso (nel nostro casi i file sdlxliff). Qualsiasi altro file 
verrà considerato come un riferimento per ricerche ad hoc. 

Durante il QA, può essere necessario effettuare delle ricerche nei file 
sdlxliff e nel glossario o nella memoria di traduzione. A tal fine, 
utilizzare la scheda Search di ApSIC Xbench. La schermata in basso 
mostra in che modo vengono organizzate le informazioni nel progetto 
generato da Xbench. 

 
Quando si individua un elemento delle schede Search o QA che si 
desidera modificare, è sufficiente selezionarlo, fare clic con il pulsante 
destro del mouse e fare clic su Edit Source. In alternativa, premere i tasti 
di scelta rapida Ctrl+E che corrispondono al comando Edit Source. In 
questo modo, SDL Trados Studio passerà in primo piano e il file 
interessato verrà aperto nella vista Editor, all’altezza del segmento 
selezionato in ApSIC Xbench. 
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Una volta effettuata la necessaria modifica in SDL Trados Studio, è 
possibile tornare a Xbench utilizzando la combinazione rapida Alt+Tab.  

Terminati i cambiamenti richiesti dal QA in SDL Trados Studio, si 
consiglia di verificare il risultato premendo nuovamente l’icona nella 
barra multifunzione. Dopo aver fatto clic sull’icona della barra 
multifunzione, il plugin Xbench salverà ogni eventuale file non salvato e 
creerà un nuovo progetto di Xbench con i file aggiornati. 

Se si desidera eseguire un QA limitato a una selezione di file del progetto 
di SDL Trados Studio, aprire la vista Files di SDL Trados Studio, 
selezionare i file desiderati, fare clic con il pulsante destro del mouse per 
aprire il menu popup e scegliere Run QA in Selected Files with 
Xbench. 
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Come eseguire il QA sui 
file di memoQ 

Istruzioni valide da 
memoQ 6 a memoQ 2014 
fino alla build 51 

ApSIC Xbench può caricare file .mqxliff e .mqxlz di memoQ. Per 
aggiungere un documento di memoQ a un progetto di Xbench, sono 
richiesti i seguenti passaggi:  

1 In memoQ, selezionare il documento, scegliere Export bilingual, 
indicare memoQ XLIFF come formato di output e fare clic su 
Export.  

2 In ApSIC Xbench, scegliere Project->Properties, scegliere Add e 
infine scegliere memoQ File.  

Tuttavia, il comando Editor Source che consente di passare allo stesso 
segmento in memoQ presenta una limitazione importante: funziona solo 
se l’attuale documento mqxliff risulta aperto in memoQ. 

Pertanto, al fine di ottenere il massimo dall’integrazione con memoQ, è 
necessario inserire il contenuto di cui si desidera effettuare il QA in un 
unico file .mqxlz. A tal fine, creare una vista in memoQ ed esportarla. 
Pertanto, la procedura raccomandata per eseguire il QA di file di memoQ 
è la seguente: 

1 In memoQ, selezionare nella vista Translations tutti i documenti di 
cui si desidera eseguire il QA dal progetto corrente, fare clic con il 
pulsante destro del mouse e selezionare Create View. Digitare un 
testo simile a ToXbench nel Name of the view, scegliere Simply glue 
documents together e fare clic su OK. 

2 In memoQ, nella scheda Views, selezionare ToXbench, fare clic con il 
pulsante destro del mouse e scegliere Export bilingual. Scegliere 
memoQ XLIFF e fare clic su Export. 

3 Aprire la vista ToXbench nell’editor, in modo che venga mostrata 
nella griglia di traduzione. 

4 In ApSIC Xbench, scegliere Project->Properties, scegliere Add e 
infine scegliere memoQ File. Aggiungere il file ToXbench.mqxlz 
creato nel punto 2. 

Con questa configurazione, ovvero con la vista ToXbench aperta in 
memoQ e il file mqxlz corrispondente caricato in ApSIC Xbench, 
scegliendo Edit Source in ApSIC Xbench la posizione ottenuta in 
memoQ corrisponderà allo stesso segmento attualmente selezionato in 
Xbench.  
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Ciò significa che se viene rilevato un errore da correggere durante il QA 
del file di memoQ in Xbench, sarà possibile correggerlo direttamente in 
memoQ scegliendo semplicemente Edit Source (Ctrl+E). 

Istruzioni valide per 
memoQ 2014 build 51 o 
versione successiva 

A partire da memoQ 2014 build 51 è disponibile una nuova funzione che 
semplifica l’interoperabilità con ApSIC Xbench. Da questa build di 
memoQ, le istruzioni per eseguire il QA di un progetto memoQ variano 
come indicato di seguito: 

1 In memoQ, selezionare i documenti, scegliere Export bilingual, 
scegliere memoQ XLIFF come formato di output e fare clic su 
Export in una cartella, ad esempio ToXbenchQA. 

2 In Windows Explorer, selezionare la directory ToXbenchQA, fare clic 
con il pulsante destro del mouse e scegliere Run QA in Xbench (tale 
procedura risulta più rapida rispetto all’utilizzo di Project-> 
Properties in ApSIC Xbench. 

3 Eseguire i controlli QA (o le ricerche terminologiche) normalmente in 
ApSIC Xbench. Durante i controlli QA o le ricerche terminologiche, 
se si rileva un segmento di memoQ da modificare, è sufficiente 
selezionarlo, fare clic con il pulsante destro del mouse e scegliere 
Edit Source (Ctrl+E). 
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Qui sono riportati svariati argomenti che forniranno informazioni 
aggiuntive sulle funzioni di ApSIC Xbench. 
 

Informazioni aggiuntive 
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Utilizzo delle impostazioni 
di ApSIC Xbench 

Sul menu Tools, fare clic su Settings per aprire la finestra di dialogo 
Settings come mostrato nell’illustrazione in basso. 

 
In questa finestra di dialogo è possibile configurare ApSIC Xbench in 
maniera tale da avviarlo sempre in con il layout ingrandito (consigliato) 
ed anche modificare le combinazioni di tasti predefinite nel sistema. Nota: 
la modifica delle combinazioni rapide di tasti dovrebbe avvenire solo per 
evitare conflitti con altre applicazioni che utilizzano le stesse 
combinazioni rapide. 

I campi in questa finestra di dialogo sono: 

Maximize on Startup. Se attivato, ApSIC Xbench viene visualizzato in 
modalità ingrandita all’avvio. Si consiglia di attivare questa opzione 
poiché la modalità ingrandita è quella che fornisce la maggiore quantità 
di informazioni nello stesso tempo. 

Le impostazioni seguenti appartengono al gruppo Hotkeys.  

Disable. In questa casella di controllo è possibile disattivare le 
combinazioni rapide di tasti preimpostate in ApSIC Xbench. Si 
consiglia di non attivare l’opzione “Disable” poiché una delle 
caratteristiche più apprezzate di ApSIC Xbench è proprio la capacità 
di avviare ricerche direttamente da altre applicazioni. 
Source Hotkey. Questa combinazione rapida di tasti ricerca il 
contenuto degli appunti nel testo di arrivo. Per impostazione 
predefinita è Ctrl+Alt+Insert. 
Target Hotkey. Questa è la combinazione rapida di tasti predefinita 
per avviare la ricerca “inversa”, ossia per ricercare il contenuto degli 
appunti nel testo di arrivo. Per impostazione predefinita è 
Ctrl+Alt+Backspace. 
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Si consiglia di non modificare le combinazioni rapide di tasti, a meno che 
non entrino in conflitto con le impostazioni di un’altra applicazione. 

Internet Search / Open in default browser. Se attivata, apre le ricerche 
Internet nel browser predefinito anziché nel browser contenuto in ApSIC 
Xbench. 

Transfer Method. In ApSIC Xbench sono gli appunti (blocco note) il 
sistema di trasferimento tra le varie applicazioni Windows e ApSIC 
Xbench. Di solito il metodo più comodo e affidabile consiste nel lasciare 
invariate le impostazioni predefinite Manual Copy e Manual Paste, ma 
in alcuni casi (ad esempio con applicazioni che non presentano 
caratteristiche standard per le combinazioni di tasti per il copia e incolla), 
potrebbe rivelarsi necessario modificare queste impostazioni per lavorare 
meglio con ApSIC Xbench. 

Le opzioni disponibili per il metodo di trasferimento in Input sono: 

Copy Message. Quando si preme la combinazione di tasti 
Ctrl+Alt+Ins, ApSIC Xbench invia una COPIA del messaggio 
all’applicazione per copiare il testo selezionato negli appunti, 
dopodiché effettua una ricerca utilizzando il contenuto degli appunti. 
Solo un limitato numero di applicazioni accetta questa tecnica, ma 
essa presenta il vantaggio di evitare la copia manuale del testo negli 
appunti (di solito con la combinazione Ctrl+Ins). 
Manual Copy. In questa modalità, ApSIC Xbench presuppone che 
l’utente abbia già copiato il testo da ricercare negli appunti. Sembra 
più complicato ma presenta il vantaggio che molte applicazioni 
adottano la combinazione di tasti Ctrl+Ins per copiare il testo, 
permettendo all’utente di ritrovare regole simili in varie applicazioni. 
Tuttavia, se l’applicazione di editing ha tempi di risposta lenti, si può 
ritenere troppo rapida la combinazione Ctrl+Insert, Crl+Alt+Insert per 
l’applicazione. 
Keyboard Emulation (Ctrl+Insert). In questo modalità, ApSIC 
Xbench invia la combinazione di tasti Ctrl+Ins all’applicazione di 
editing ed in seguito effettua la ricerca. In questo modo, l’utente non 
deve premere Ctrl+Ins prima della ricerca. È possibile che alcune 
applicazioni non supportino questa modalità. 
Keyboard Emulation (Ctrl+C). In questo modalità, ApSIC Xbench 
invia la combinazione di tasti Ctrl+C all’applicazione di editing ed in 
seguito effettua la ricerca. In questo modo, l’utente non deve premere 
Ctrl+C prima della ricerca. È possibile che alcune applicazioni non 
supportino questa modalità. 

Le opzioni disponibili per il metodo di trasferimento in Output sono: 

Paste Message. Quando si preme il tasto invio per selezionare una 
traduzione, ApSIC Xbench invia un messaggio PASTE. Solo un 
limitato numero di applicazioni accetta questa tecnica, ma essa 
presenta il vantaggio di evitare l’incollaggio manuale del testo negli 
appunti (di solito con la combinazione Maiusc+Ins). 
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Manual Paste. In questa modalità, ApSIC Xbench copia il testo di 
arrivo della voce selezionata negli appunti se si preme il tasto Invio 
per selezionare una traduzione. Si prevede che l’utente prema la 
combinazioni di tasti Maiusc+Ins (oppure la combinazione di tasti 
corrispondente per copiare il testo nell’applicazione). È la modalità 
predefinita e consigliata per ragioni di coerenza tra le varie 
applicazioni. 
Keyboard Emulation. In questa modalità, quando viene selezionata 
una voce e si preme il tasto invio per copiare la selezione negli 
appunti, ApSIC Xbench invia il testo di arrivo nell’applicazione di 
editing. 
Keyboard Emulation (Ctrl+V). In questa modalità, quando viene 
selezionata una voce e si preme il tasto invio per copiare la selezione 
negli appunti, ApSIC Xbench invia il testo di arrivo simulando la 
combinazione di tasti Ctrl+V nell’applicazione di editing. 

Fare clic sulla scheda Colori di questa finestra di dialogo per modificare i 
colori predefiniti nella finestra principale. Viene visualizzata la finestra 
seguente: 

 
Le impostazioni in questa scheda sono le seguenti: 

 Background color when zoomed. In ApSIC Xbench, sono 
disponibili due diverse modalità di visualizzazione: “overview”, in 
cui sono visualizzati solo alcune termini per ogni priorità, e la 
modalità “zoomed”, in cui sono visualizzati tutti i termini di una 
priorità. In questa opzione si definisce il colore dello sfondo utilizzato 
nella modalità “zoomed”, per segnalare che non si è in modalità 
“overview” (la modalità predefinita è “overview”). 

 Key Terms priority. È possibile selezionare il colore che sarà 
utilizzato per i termini appartenenti alla Key Terms Priority. Per 
definire un glossario come glossario di Key Terms, scegliere Project-
>Settings. 

 High Priority. È possibile selezionare il colore che sarà utilizzato per 
i termini appartenenti alla High Priority.  

 Medium Priority. È possibile selezionare il colore che sarà utilizzato 
per i termini appartenenti alla Medium Priority. 
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 Low Priority. È possibile selezionare il colore che sarà utilizzato per 
i termini appartenenti alla Low Priority. 

 Background color when nothing found. È possibile selezionare il 
colore dello sfondo che viene visualizzato nella casella di ricerca 
quando non viene trovato alcun termine. 

Fare clic sulla scheda Internet per configurare le impostazioni Internet: 

 
Nella scheda Internet è possibile definire il percorso URL utilizzato per 
effettuare ricerche mirate su Internet, ad esempio in un dizionario. È 
possibile impostare tutte le ricerche che si desiderano, ma solamente per 
le prime 10 è possibile assegnare una combinazione veloce di tasti, o 
Alt+n se si lavora in ApSIC Xbench o Ctrl+Alt+n da qualsiasi 
applicazione Windows (in quest’ultimo caso la tastiera numerica deve 
essere attivata) ; n può essere un numero da 0 a 9, in cui 0 corrisponde 
alla decima voce nella lista. 

Per aggiungere una nuova voce, premere il tasto freccia giù nell’ultima 
voce. Per eliminare una voce, rimuovere tutto il testo dalla riga.  

È possibile utilizzare i pulsanti Up e Down per spostare una voce in alto 
o in basso nell’elenco. 

Le prime 10 voci con un tasto assegnato appariranno nel menu Internet. 

È possibile scegliere Internet->Capture URL per acquisire URL in 
questo elenco. 

La scheda Miscellaneous consente di specificare svariate impostazioni 
che possono migliorare la propria esperienza mano a mano che si 
acquisisce familiarità con ApSIC Xbench. 
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Le impostazioni in questa scheda sono le seguenti: 

 Check weekly for new versions. Se questa casella di controllo è 
attiva, ApSIC Xbench verificherà una volta a settimana l’esistenza di 
aggiornamenti disponibili. 

 Enable alternative project. Se questa casella di controllo è attiva, 
ApSIC Xbench mantiene in memoria l’ultimo progetto aperto prima 
di quello attivo. Per passare ad un progetto all’altro, scegliere 
Project->Switch to Alternative Project. Per eliminare l’alternative 
project e liberare la memoria utilizzata, selezionare Projects->Forget 
Alternative Project. 

 Load last project when ApSIC Xbench starts. Se questa casella di 
controllo è attiva, ApSIC Xbench caricherà in avvio il progetto aperto 
l’ultima volta che il programma è stato disattivato. 

 Show warning when copying fuzzy match. Se questa casella di 
controllo è attiva, ApSIC Xbench visualizzerà un messaggio di avviso 
nel caso in cui si prema Invio per inserire una voce selezionata che 
non corrisponde esattamente al termine ricercato. 

 Show warning when shutting down. Se questa casella di controllo è 
attiva, ApSIC Xbench visualizzerà un messaggio di avviso in caso di 
arresto. 

 Show QA Options Changed from Default. Se questa casella di 
controllo è attiva, i risultati del QA includeranno in cima un elenco di 
tutte le impostazioni QA che non presentano il valore predefinito 
stabilito da ApSIC. 

 Match Whole Words in QA Check for Key Terms. Se viene 
spuntata questa casella di controllo, il termine target di una voce di un 
glossario definito come Key Terms dovrà corrispondere a una parola 
intera (tenere presente che il termine source viene sempre corrisposto 
come parola intera.)  

 Default Project Directory. In questo campo è possibile specificare la 
cartella predefinita per i progetti personali di ApSIC Xbench. 
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Nella scheda Text Editor è possibile configurare gli argomenti delle 
righe di comando per l’editor di testo quando si utilizzano le funzionalità 
Edit Source per la ricerca o i risultati di QA per un glossario in formato 
.txt. Ciò include File delimitati da tabulazione, Memorie esportate di 
Trados, Memorie di Wordfast e Glossari di Wordfast. Se configurato 
correttamente, è possibile aprire il file direttamente in corrispondenza 
della riga da cui proviene il segmento selezionato con il comando Edit 
Source.  

 
Se si sceglie un editor di testo, occorre assegnare i valori ai seguenti 
campi: 

 Path to Executable. Indicare il percorso del file .exe dell’editor di 
testo. È possibile utilizzare il pulsante puntini di sospensione (...) per 
individuare il file .exe. 

 Command-line Parameters. Con questi campi è possibile costruire 
la riga di commando che dovrebbe essere trasmessa all’editor. È 
possibile utilizzare diverse variabili che ApSIC Xbench sostituirà con 
i valori. 
 $Filename: il nome del file, compreso il percorso. 
 $Line: il numero di riga del segmento nel file di testo. La riga 

indica il punto in cui si trova il testo di arrivo. 
 $Column: la colonna della riga in cui si trova il testo di arrivo. 
 $Segment: il numero del segmento nel file di testo. 
Per esempio, per configurare TextPad 4 per il posizionamento di riga, 
occorre selezionare il file eseguibile Text Pad e fornire le seguenti 
specifiche nell’apposito campo Command-Line Parameters: 
$filename($line,$column). In modo simile, per configurare Notepad++, 
selezionare il relativo file eseguibile e specificare quanto segue in 
Command-Line Parameters: $filename -n$line. Altri editor di testo 
richiedono valori differenti in questo campo. Si prega di riferirsi alla 
documentazione dell’editor di testo per tali valori. 
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Nella scheda TMX Editor è possibile configurare gli argomenti delle 
righe di comando per l’editor TMX quando si utilizzano le funzionalità 
Edit Source per la ricerca o i risultati di QA per un glossario in formato 
.tmx. Se configurato correttamente, è possibile aprire il file direttamente 
in corrispondenza della riga da cui proviene il segmento selezionato con 
il comando Edit Source.  

 
Se si sceglie un editor TMX, occorre assegnare i valori ai seguenti campi: 

 Path to Executable. Indicare il percorso del file .exe dell’editor di 
testo. È possibile utilizzare il pulsante puntini di sospensione (...) per 
individuare il file .exe. 

 Command-line Parameters. Con questi campi è possibile costruire 
la riga di commando che dovrebbe essere trasmessa all’editor. È 
possibile utilizzare diverse variabili che ApSIC Xbench sostituirà con 
i valori. 
 $Filename: il nome del file, compreso il percorso. 
 $Line: il numero di riga del segmento nel file di testo. La riga 

indica il punto in cui si trova il testo di arrivo. 
 $Column: la colonna della riga in cui si trova il testo di arrivo. 
 $Segment: il numero del segmento nel file di testo. 
Per esempio, per configurare OKAPI Olifant per il posizionamento di 
segmenti, occorre selezionare il file eseguibile Olifant e fornire le 
seguenti specifiche nell’apposito campo in Command-Line 
Parameters: $Filename row=$Segment col=trg edit=yes. Altri editor 
TMX richiedono valori differenti in questo campo. Si prega di 
riferirsi alla documentazione dell’editor TMX per tali valori.  
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La scheda Studio Plugin consente di configurare impostazioni che 
modificano il comportamento del plugin ApSIC Xbench per SDL Trados 
Studio. 

 
Le impostazioni disponibili su questa scheda sono le seguenti: 

 Add first local termbase. Se spuntato, il plugin aggiungerà il proprio 
termbase locale definito per il progetto di SDL Trados Studio al 
progetto di QA in Xbench creato dal plugin. Il termbase riceverà una 
priorità alta nel progetto in Xbench. 

 Add first local translation memory. Se spuntato, il plugin 
aggiungerà il proprio termbase locale definito per il progetto di SDL 
Trados Studio al progetto di QA in Xbench creato dal plugin. Alla 
memoria di traduzione verrà assegnata una priorità bassa nel progetto 
in Xbench. 

 Use this Xbench project template. Se spuntato, indicherà al plugin 
di aggiungere i file di Studio al progetto .xbp in Xbench indicato nel 
campo in basso. Utilizzare il pulsante puntini di sospensione (...) per 
aprire una finestra di Esplora risorse e selezionare il file .xbp. 

La scheda Transifex consente di configurare l’utente Transifex che verrà 
utilizzato per recuperare informazioni di progetto da Transifex e la 
propria lingua di arrivo predefinita. 
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Gli elementi disponibili su questa scheda sono i seguenti: 

 User name. Il nome utente di Transifex. 
 Password. La password dell’utente di Transifex. 
 Test Login. Fare clic su questo pulsante per controllare se le 

credenziali di Transifex sono state digitate correttamente. 
 Default target language. Digitare qui la lingua di arrivo predefinita 

per i progetti in Transifex. Premendo il pulsante puntini di 
sospensione (...), apparirà un elenco delle lingue di arrivo valide. 
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Suggerimenti rapidi su 
ApSIC Xbench 

Nel presente capitolo sono descritte le funzionalità più importanti di 
ApSIC Xbench. L’obiettivo è quello di fornire una rapida panoramica 
sulle potenzialità di ApSIC Xbench. 

Si consiglia vivamente la lettura del capitolo per ottenere il massimo da 
ApSIC Xbench con il minimo sforzo. 

 ApSIC Xbench non è un indicizzatore. Il programma legge il 
contenuto dei file ogni volta che si carica un progetto e cerca di 
rispondere in maniera veloce alle query terminologiche. Di 
conseguenza, il caricamento di tutti i glossari Microsoft per una delle 
principali lingue può richiedere svariati minuti e una significativa 
quantità di memoria. Se si desidera lavorare con una mole notevole di 
materiale di riferimento, nell’ordine di decine di milioni di parole, è 
necessario accertarsi di avere a disposizione almeno 1 GB di 
memoria. Se non si ha un computer molto potente, si consiglia di non 
caricare tutti i glossari Microsoft, bensì una selezione più ristretta con 
le aree più attinenti al progetto di traduzione in corso. 

 Una volta caricato, ApSIC Xbench rimane attivo in background fino a 
quando non viene chiuso manualmente. Quando ApSIC Xbench è 
attivo, viene visualizzata una gemma rosa nella barra di sistema. Per 
rimuovere ApSIC Xbench dalla memoria, occorre chiuderlo, ad 
esempio facendo clic con il pulsante destro del mouse sull’icona nella 
barra di sistema e selezionando quindi il comando Shut Down 
Xbench. 

 Quando ApSIC Xbench è attivo, può essere richiamato da qualsiasi 
applicazione Windows con la sequenza di tasti Ctrl+Alt+Insert. Se 
nell’applicazione è presente del testo evidenziato, ApSIC Xbench lo 
ricerca automaticamente. I tasti per l’avvio della ricerca sono 
modificabili. 

 Oltre ai glossari software di Microsoft, ApSIC Xbench può lavorare 
su molti altri formati di input e su varie applicazioni CAT tra cui Trados, 
SDLX, Transit, Wordfast, IBM TranslationManager, e altri standard 
di settore quali TMX, TBX o XLIFF. È possibile utilizzare vari 
formati di file in un progetto Xbench assegnando priorità ad ogni file 
sorgente per definire il processo decisionale terminologico in uno 
specifico progetto di traduzione. È possibile salvare ogni progetto 
ApSIC Xbench per un successivo riutilizzo. 

 Per copiare negli appunti il testo di arrivo della voce selezionata, 
premere il tasto Invio nella finestra principale. Il tasto Invio chiude la 
finestra, copia il testo e si prepara ad incollarlo nell’applicazione in 
cui è possibile modificare la traduzione utilizzando la combinazione 
di tasti Maiusc+Ins Ciò si rivela molto utile quando si traduce la 
documentazione di un’applicazione in cui le stringhe del software 
sono caricate in un progetto ApSIC Xbench. 
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 È possibile effettuare controlli di QA utilizzando la scheda QA. I 
controlli QA sono eseguiti solo con riferimento a glossari definiti come 
ongoing translation (traduzione in corso). Una funzionalità molto utile 
di QA è rappresentata dalle liste di controllo (checklist), con cui è 
possibile eseguire in modalità batch una serie di controlli predefiniti 
sfruttando le potenti capacità di ricerca di ApSIC Xbench. 

Dopo aver acquisito dimestichezza con le principali caratteristiche del 
prodotto, si consiglia di leggere attentamente la documentazione per 
imparare le altre numerose funzionalità utili disponibili. 
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Dove trovare i glossari 
software Microsoft ed 
Apple 

Individuazione dei 
glossari Microsoft 

I glossari software di Microsoft erano precedentemente disponibili e 
scaricabili tramite FTP dal sito Microsoft, mentre adesso sono disponibili 
solo a pagamento tramite sottoscrizione a MSDN. 

Ogni lingua si trova all’interno di in un file separato .zip contenente tutti i 
glossari dei prodotti Microsoft localizzati in quella lingua. La dimensione 
di ogni file può variare da 1 ad oltre 100 Mb, secondo il numero di 
prodotti localizzati in quella lingua da Microsoft. 

Individuazione dei 
glossari Apple 

Al momento di questa pubblicazione, i glossari software per Apple Mac 
OS X sono disponibili al seguente indirizzo, in presenza di un ID Apple: 

 http://developer.apple.com/internationalization/downloads/ 

I glossari di ogni lingua sono in formato Macintosh Disk Image 
(estensione .dmg). Per caricare i glossari Mac OS in ApSIC Xbench, 
occorre estrarre il file .ad contenuto in queste immagini di disco. A tale 
fine, utilizzare il software UltraISO 
(http://www.ezbsystems.com/ultraiso/index.html). 
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Con ApSIC Xbench è possibile definire i collegamenti Internet da 
utilizzare per ricercare i termini in Internet. ApSIC Xbench integra un 
browser di base, ma con la combinazione di tasti Ctrl+W, è possibile 
aprire il browser Internet predefinito del sistema nella pagina 
corrispondente a quella visualizzata con il browser ApSIC Xbench. 
 

Internet 
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Ricerche su Internet 
In ApSIC Xbench è presente una scheda Internet che fornisce un 
collegamento aggiuntivo alle fonti informative e terminologiche 
disponibili sul Web. Nella figura sottostante è visualizzata una ricerca su 
Google eseguita all’interno di ApSIC Xbench. 

 
In ApSIC Xbench sono disponibili alcuni collegamenti Internet 
predefiniti, ma l’utente è libero di modificarli o definire i nuovi 
collegamenti richiesti. I collegamenti predefiniti sono accessibili 
utilizzando uno dei seguenti metodi: 

Spostarsi sulla scheda Internet, selezionare la sorgente desiderata nel 
campo Website, digitare la stringa di ricerca nel campo Text to search e 
premere Enter. 
Quando ApSIC Xbench rappresenta l’applicazione corrente, premere 
Alt+n, in cui n corrisponde a un qualsiasi numero da 0 a 9. Lo 0 
corrisponde alla decima voce nell’elenco. Verrà utilizzato per la ricerca il 
termine corrente nel campo Source della scheda Project o nel campo 
Text to search della scheda Internet. Il numero corrisponde al numero 
dell’elenco dei collegamenti presenti in Tools->Settings->Internet. 

Da un’applicazione Windows qualsiasi, evidenziare il termine ricercato e 
premere la combinazione di tasti Ctrl+Insert seguita da Ctrl+Alt+n, in cui il 
numero n deve essere inserito con il tastierino numerico attivato. 
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Definizione dei 
collegamenti rapidi con 
Internet 

I collegamenti rapidi con Internet si impostano con il comando Internet-
>Define Links. I collegamenti rapidi sono molto facile da impostare, 
basta procedere come segue: 

1 Aprire l’elenco di collegamenti rapidi in Internet->Define Links. Per 
creare una nuova voce, basta spostare il cursore sotto l’ultima voce.  

 
2 Eseguire una ricerca nel sito Web da controllare. Per esempio, 

effettuare la ricerca del termine xbench su Google. 
3 Copiare l’URL (simile al seguente) negli appunti: 

http://www.google.com/search?hl=en&lr=&ie=UTF-8&q=xbench 
4 Incollare l’URL in una voce della finestra e sostituire il termine 

ricercato con %s come nella precedente figura. Nelle query 
successive che utilizzano la stessa stringa di ricerca, ApSIC Xbench 
sostituirà la sequenza %s con la stringa di ricerca. 

5 Assegnare un nome al collegamento Internet spostando il cursore 
nella colonna Name e inserendo il nome. Questo nome verrà 
visualizzato nel campo Website della scheda Internet e anche nel 
menu a discesa Internet. 

6 Se nell’elenco si desidera spostare verso basso il collegamento attivo 
(modificando così anche il numero) è possibile fare clic sui pulsanti 
Up e Down posizionati nella parte inferiore della finestra 
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Se si nota un collegamento interessante mentre si naviga con la scheda 
Internet di ApSIC Xbench, è possibile aggiungerlo rapidamente 
all’elenco di pagine utilizzando il comando Internet->Capture URL. 

Se la barra degli strumenti è attiva, sono disponibili vari pulsanti della 
barra che permettono di navigare nella pagine Internet. Con un pulsante si 
può aprire una finestra di Internet Explorer con la stessa pagina che si sta 
guardando. È possibile anche usare il comando Internet ->Open 
Browser o la combinazione veloce Ctrl+W. 
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Bug e suggerimenti 
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Segnalazione di bug e 
invio di suggerimenti 

I feedback dei nostri clienti su qualsiasi errore rilevato nel programma 
sono i benvenuti. Siamo aperti a suggerimenti in merito a come 
migliorare le aree che risultano meno intuitive.  

Per inviare segnalazioni di bug o suggerimenti, visitare la pagina 
http://www.xbench.net/index.php/support/submit-bug. 

Qualsiasi informazione inviata verrà considerata confidenziale e verrà 
utilizzata unicamente per risolvere il problema. 
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